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About Producer
With increasing global demand for original animated content, and productions being produced from different 
sites worldwide with more and more work from home, there is a growing need for tools that ensure efficient 
production development. Studios everywhere have relied on spreadsheets and DIY solutions to help keep 
teams aligned, and move productions forward along timelines and within budgets.

Producer 22 provides real-time access to the progress of your animated features and series, making it easier to 
manage global production processes. Track tasks, assets, scenes, production progress, team management, 
efficiencies across departments, reporting and more. Plus, Producer seamlessly integrates with the software 
your team needs to get the job done including Storyboard Pro and Harmony.

Our all-in-one production management and tracking tool provides global visibility of your studio’s activities, 
giving you access to up-to-date information and enabling you to make the best decisions at the right time.
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Benefits
 l Measurable increases in studio production efficiency

 l On-time and on-budget feature and series delivery, enabling massive savings

 l Real-time visibility of full production pipeline for quick and efficient decision making

 l Reporting for all levels of studio management 

 l User-friendly interface makes learning easy

 l Backed by the industry’s leading 2D animation software company who understands the needs of global 
studios

 l We are accessible, with support and our community being our focus — a leader in 2D animation for 
over 25 years

 l Seamless integration with industry-leading 2D animation production (Harmony) and storyboard 
software (Storyboard Pro)

 l Multi-production environment in one global platform

 l Advanced potential for team collaboration, effective communications and task delegation 

10
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Features
 l Customizable workflows, user profiles and roles

 l User-friendly interface

 l Dashboards and detailed reporting

 l Job task reports

 l Progress report

 l Team productivity reports

 l Access to in-app analytics and graphs

 l Graphical scene status dashboard

 l Customizable & Automated triggers

 l Advanced filtering of projects, tasks, scenes, searches and more

 l Versioning

 l Potential for multi-production tracking

 l Scheduling & gantt charts

 l Central Hub for connectivity of every team member

 l Notes and annotations

 l Task, scene and asset assignment

 l Asset categorization, labeling and tags for simplified search

 l Thumbnails and preview videos for easy access

 l Assets assembly and scene set up in Harmony

 l Third-party software integration

 l Batch import and export to CVS

 l Advanced reporting: task reports, progress reports, team productivity, and more

 l Multi-language interface (English, French, Spanish, Japanese, Standard Chinese)

 l Available for deployment on premises or on the cloud

11



User Guide
The following guide explains how to use all the core functionalities of Producer. It is addressed to all kinds of 
project contributors, depending on the task they wish to accomplish.

12
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Chapter 1: Producer Interface

Chapter 1: Producer Interface

Overview

Producer aims to help studios manage their productions from start to end, and offers functionalities for 
managers, supervisors and artists alike.

Access to Producer is protected by a login screen. After logging in, its main interface consists of a main 
navigation bar at the top, and a contents section underneath.
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Top Level Navigation
You can navigate the main sections and features available in Producer through its  top navigation bar.

NOTE 

Users will have access to different pages and menu items based on their level of permissions — 
see Creating Users.

Page Description

Displays the list of Producer Projects. Different projects can have specific permissions, 
workflows, and connect to separate Harmony servers.

Production
Allows supervisors and directors to manage workloads and track the progress of episodes, 
scenes,and tasks.

Open Tasks Allows a user to see the work assigned to them, update their tasks, and log work hours.

Assets > 
Manage

Allows supervisors and directors to track asset tasks and manage assets.

Assets > 
Assembly

Allows supervisors to associate assets to different environments, jobs, or scenes, and to 
actually assemble those assets into Harmony Server Scenes.

Review Allows supervisors and directors to review submitted scenes and assets, approve tasks, add 
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Page Description

notes, and send work for retake.

Reports
Allows supervisors, directors, and producers to analyze data and progress through a variety of 
customizable reports.

Views Allows users to create and share custom views with custom columns.

Settings
Allows administrators to configure Producer by creating users, setting permissions and 
groups, and managing projects.

Settings > 
Workflows

Allows administrators to configure the current project’s workflows.

Project Selector Allows users to quickly switch between projects.

User Notification Feed.

Link to Producer Documentation

Allows users to access standard options (Personal Settings, Logout, About, Downloads & 
Resources…) as well as administrator specific settings (General Settings, Importing Users from 
Harmony)

NOTE 

Users will have access to different pages and menu items based on their level of permissions—see 
Creating Users.
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Production Toolbar
A lot of the operations in the Production and Asset pages are performed through the Production toolbar.

Search and Filtering Tools
You can use the Search field and filtering tools to only display scenes and assets matching specific criteria.

View Tools 
You can change the display style of the Production and Asset tables to include more or less information. For 
example, you can open the detail side panel or change the view style to thumbnails.

List button
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Tiles button

Column Selector 

With the Column Selector you can choose how many columns are displayed in your main list. Uncheck the 
boxes on the ones you wish to hide.
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Toggle Bottom and Side Panels
You can display additional information for each selected job, scene or asset using the side and bottom panel.
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Additional Options for Selected Items
When you enable the checkbox on a Job, more options are available to edit your selection.
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Adding and Removing Columns
Depending on your workflow needs, you can add and remove columns from the production or asset list.

How to add and remove columns

 1. In the top menu, click Production or Assets > Manage.

The assets list opens.

 2. In the toolbar in the top-right corner above the assets list, click on the  Manage Columns  icon.

A menu appears with all the available column options for the asset list. Columns that are currently 
displayed in the list are checked, and those that are hidden are unchecked.

 3. Check each column box that you wish to add, and uncheck each column box that you wish to 
remove.

When adding columns, the newest column added will by default appear on the right.

NOTE 

You should always keep the Selector column enabled. This column contains a checkbox for 
each asset, allowing you to perform certain actions and select several assets simultaneously.
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Creating Views 
You can create custom views and share them with users to display the Production or Asset list using a specific 
set of columns and filtering options. You can create as many views as needed.

How to save a custom view

 1. Select Production or Assets > Manage. 

 2. From the page toolbar, click on the Column Selector  icon. 

 3. Check or uncheck any boxes of columns you wish to display or hide.

NOTE 

The order of the tabs will be displayed from left to right as you check the boxes 
in that order. You can edit this later by grabbing the name in the column header 
and sliding it left or right to switch the order.

More custom fields can be entered using the Toggle Search Panel.

 4. When finished, in the page toolbar, go to More > Save New View. 

The Save New View window opens.

 5. In the Name field, type in a name for the new view. 

 6. Check or uncheck the following options:

 l Save Current View Settings Only: saves the columns and ordering of columns in the 
view.

 l Save Current Environment or Job: save the current location of the view.

 l Save Search Data: saves the search data.

 7. In the drop-down menu, select one of the following:  
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 l Add Link to Views: adds the link to views that you can only see.

 l Add Link to Shared Views: adds a link that everyone in the production can see and 
use.

 8. Click Save View.

Under Shared Views in the Views tab you will see the shared views from the current production. 

Under My Views from the Views tab you will see your personal saved views from the current 
production. 
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Managing Views
Once you have created custom views, you can manage them to remove them or manage the sharing settings.

How to manage views

 1. Select Views > Manage Views.

My Saved Views and Shared Views appears. 

 2. In the Saved Views section, right-click on a saved view. 

The option menu opens.  If you click directly on a saved view, it will open immediately. 

 3. You can drag and drop saved views into the Shared Views section for everyone in the production to 
see and use.

23



Login
Access to Producer main interface is protected by a login screen, which allows logging in directly using 
Producer credentials, or using Single Sign-On service.

 1. When entering Producer, user is asked to enter their username.

 2. The next screen will either prompt the user for their password, or redirect them to a Single Sign On 
service. Press tab or click on the “password” field and enter your password, then hit the Login” button.

 3. Upon first successful login, user will be asked to change their Producer password.

NOTE 

Even when Single Sign-On is used, users will still be requested to set their Producer password.
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Logout
After a certain time of inactivity, users will be logged out automatically.

To logout manually, go to the main navigation Top Right Dropdown and select Logout.

User will be brought back to the login screen.
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Downloads and Resources
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About
This screen displays information about Producer:

 l Current Version

 l License Type and expiration
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General Settings (Administrator)
Privileged users (administrators) may view and configure a certain number of site or project wide settings from 
the main navigation bar > Top Right dropdown > General Settings.

These settings are not available to normal users.
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Harmony Integration
Harmony Integration allows configuring preferences when interacting with Harmony.

These settings may be configured per Producer project.

This allows Producer to interact with different Harmony servers, should the need arise.

Option Description

WebCC Queue
This is the communication channel between Producer and Harmony, and is used as WebCC 
startup parameter.  Refer to Chapter 9.1 - Working with Harmony Database for more 
information on configuring WebCC. 

Multi-layer 
Image

This option is used when assembling multi-layer image assets (such as .psd files) in Harmony. 
Depending on the chosen option, Harmony will either create a single image, or multiple images 
based on layer names when copying or pasting the asset in Harmony scenes. Refer to Chapter 
8 - Assembly for more information. 

Alignment

This option is used when assembling assets in Harmony. 

Available options: project resolution, fit, pan. 

Refer to Chapter 8 - Assembly for more information. 

Offline Scenes

This option is used for exporting or importing offline scenes when working remotely. It 
specifies how files will be synchronized between remote users and Harmony server (WebCC). 

Options: 

 l Shared Exchange: choose this option if files are synchronized via a file sharing 
mechanism (like a network file system, or Cloud storage solution (Google Drive, 
Dropbox…). 

 l Direct WebCC Connection: choose this option if a direct communication with WebCC 
is enabled. 

Refer to Chapter 9.2. Harmony Integration - Working Remotely. 

WebCC Url

When Offline Scenes Exchange mode is set to Direct WebCC Connection, specify the url 
address of WebCC. This address must be accessible to the users working remotely, and it is 
highly recommended that it is used through a Virtual Private Network. 

If Shared Exchange option is chosen, this field may be left empty.  

Refer to Chapter 9.2. Harmony Integration - Working Remotely. 

Offline Export 
Options

This specifies the default options used when exporting a scene while working remotely.  
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Option Description

These options will be used when clicking on the “Open In Harmony” button  from the 
Production, Assets or Open Tasks pages, or when exporting from Producer Link. These options 
can be overridden from the More > Export Offline dialog.  To export scripts or master 
controllers, make sure “Other” option is selected. 
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Authentication / Single Sign-On
Authentication settings are set globally, and are the same for all projects and users.

Three authentication modes are supported in Producer:

 l Producer Built-In Login/Password

 l OpenID Connect (OIDC)

 l Security Assertion Markup Language (SAML)

OIDC and SAML are two widely used protocols which allow authorizing users to use an application (in this 
case: Producer) via an external authentication and identity provider service.

NOTE 

OIDC is usually much simpler and straightforward to configure. If available, we recommend using 
it. SAML, although also widely used, is more complex and not as well standardized. Setting up an 
OIDC or SAML Identity provider is not covered in this document.
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Producer Built-In Login

To enable Producer Login, simply ensure that the option is selected.

NOTE 

Producer Login cannot be disabled if no Single Sign-On method is specified. Even if disabled, 
Producer login and password will still be used in Producer Link and Harmony Scripts.
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OpenID Connect (OIDC)

Before proceeding, verify with Producer’s Customer Service and your own IT department that the chosen 
provider is supported.

Option Description

Protocol Single Sign-On protocol: OIDC or SAML

Issuer URL

OIDC provider issued. This URL is the base address of the OIDC service provider (and 
should be retrieved from this service). 

If properly configured, the Well-known configuration link underneath should open a valid 
file containing addresses (endpoints) to perform various operations.

Client ID OIDC provider issued. Copy this option from your OIDC provider configuration.

Client Secret OIDC provider issued. Copy this option from your OIDC provider configuration.

Callback URL
Producer issued. Add this url to the list of authorized callback urls in your OIDC provider 
configuration. Once authenticated by the OIDC service, clients will be redirected to this 
Producer url, and authenticated in Producer.

IMPORTANT 

The same email address must be set in Producer and in the OIDC service provider to allow 
authentication.
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SAML

Option Description

Protocol Single Sign-On protocol: SAML

IdP Entrypoint SAML provider issued. Identity Provider (IdP) entrypoint URL.

IdP Certificate
SAML provider issued. Identity Provider (IdP) base 64 encoded certificate. Must be entered 
on a single line.

Issuer
A unique identifier shared between Producer and SAML Identity Provider (IdP). It may be 
issued by IdP, or you may choose your own.

Callback URL
Producer issued. Add this url to the list of authorized callback urls in your SAML provider 
configuration. Once authenticated by the SAML service, users will be redirected to this 
Producer url, and authenticated in Producer.
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How-To

Enable OIDC in Producer

 1. Click on the “Edit” button

 2. Enable Single Sign-On

 3. Protocol: Select OpenID Connect.

 4. Fill-in OIDC provider issued settings: Issuer URL, Client ID, Client Secret

 5. Copy Producer Callback URL and add it to your OIDC provider administration interface list of 
callback URLs

 6. Click on “Save Changes” button

(To cancel, click “Cancel”...)

 7. Click on “Save Changes” button.

 8. Upon successfully saving, administrator will be asked to verify the new login settings. See 
Validating Single Sign-On configuration.

If an error is encountered, an error will be displayed instead:
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Enable SAML in Producer

 1. Click on the “Edit” button.

 2. Enable Single Sign-On.

 3. Protocol: Select SAML.

 4. Fill-in SAML provider issued settings: Entrypoint, Certificate (and potentially: Issuer).

 5. Copy Producer Callback URL and add it to your SAML provider administration interface list of 
callback URLs

 6. Click on “Save Changes” button

(To cancel, click “Cancel”...)

 7. Click on “Save Changes” button.

 8. Upon successfully saving, user will be asked to verify the new login settings. See Validating Single 
Sign-On configuration.

Any error filling in or saving settings will be displayed on screen.
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Validate Single Sign-On Configuration

 1. Upon clicking on the login link, the administrator will be redirected to Producer Login page. After 
filling-in their username, they will be prompted for their Producer password, or given the option to 
use Single Sign-On.

 2. Click on “Single Sign-On” button. User should be redirected to the chosen Single Sign-On Service. 
If successful, user will be automatically logged in Producer.

 3. After a successful login, the administrator may go back to the General Settings page and disable 
Producer Login.

NOTE 

The same login options apply to all users, except administrators.
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Privacy & Confidentiality
A single setting is currently available.

Option Description

Analytics

Authorizes tracking of users actions in Producer Web Interface and Producer Link. This 
option is enabled by default. 

No personal information is recorded. 

Refer to Toon Boom End User License Agreement and general policies for more 
information. 
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Notification Feed

A Notification Feed is accessible from the main navigation bar and identified by a bell icon . Whenever 

new notification events occur, a badge will appear on the bell .

Clicking on the bell will clear that badge and display a list of notifications.

Option Description

Show Read-Only Allows users to filter between read and unread notifications. 

Mark All Read Marks all notifications as read. Should an entry receive an update, it will be marked as 
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Option Description

updated.

Load More
Located at the bottom left corner, allows retrieving additional (older) updates beyond the 
initial view.

Individual Feed Entry:

The feed will be dynamically updated with new information as it becomes available during the course of an 
export or import operation.

Option Description

Read Status

Clicking on the circle icon will toggle the status between read (plain) and unread 
(blank/outline). When an update is received, the circle will appear half-filled.

Log

If a log is available for the operation, it will be accessible by clicking on the plain “file” icon.

File

When requesting an export, hovering this icon will display the name of the exported file.

Progress bar

The progress bar indicates, when appropriate, which stage the operation is at. 

For instance:  

 l when assembling assets into scenes, how many scenes have been processed (out 
of the total) 
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Actions
The Notification Feed is currently focused on providing Harmony integration related status updates:

 l Offline scene export and import

 l Assembly

 l Harmony users import
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Harmony Scene Export Request
After issuing an export request, the feed will follow the progress of the request. An “Open in Harmony” button 
is generated once WebCC has finished processing the export (although, in some cases, the file may not be 
available yet to the remote user). Hovering the file icon will display the file name and clicking on the log will 
pop up the export log, including WebCC response.
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Harmony Scene Import Request
Similarly, when an import request is made, the Notification Feed provides updates details of the import 
process.
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Harmony Assembly
Each time an assembly request is sent, that request will be tracked and updated whenever a new update is 
received. The log will display a detailed status for each asset.
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Chapter 2: Users and Permissions
Anyone using Producer on a regular basis should have their own login credentials. This allows permissions 
control as well as task assignment and effective communication within Producer. Note that the permissions 
are handled through groups, for better efficiency. A user can be part of many groups and has all the rights 
permitted to these groups.

A group has two primary functions. First, it serves to assign permissions to its members, within the context of 
a project. Second, groups can be used to facilitate task assignments. For example, if you specify that the 
Animators group are the usual assignees for the task “animation” then the animation supervisor will only have 
to choose among users that are part of the Animators group when assigning an animation task.

NOTE 

Only users with Administration permissions will be able to create users, manage groups, and set 
permissions.

Users, groups, and permissions can be accessed via the Settings page.

The Security section allows the Admin user to set permissions for groups, page access, project access, task 
access, and menu item access such as creating, deleting, or archiving.
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The Users section allows the Admin user to create new users and assign them to groups.
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Creating Users
You can assign certain users permission to access part of Producer, while restricting the use of certain features 
for others.

How to add a user

 1. In the main menu, click on Settings. 

 2. In the Settings tab, select Users.

The Users tab opens.

 3. In the second User tab, click on the Add button.
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The Create New User window opens.

 4. Enter all the information for the new user. 

 5. When finished, click the Add button.
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Editing and Adding Users to Groups
Once a new user is created, they can have their preferences created or changed. They can be found on the 
same user page. Within that you can change or view preferences/groups as well as view metadata. 

Groups

Add the user to specific groups within the production. Each group has a different set of restrictions.

 

Edit User

Allows you to edit the user profile and login credentials.
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Chapter 3: Workflows
In Producer, production tracking is based on workflows. It is a multi-stage process usually involving several 
different software. While there are commonalities, most animation studios will develop their own pipelines. 
These custom pipelines can easily be reproduced with Producer’s workflow editor. When talking about the 
process of a studio, the terms “workflow” and “pipeline” are often used interchangeably; however, we always 
use “workflow” when referring to the actual node structure in Producer. Each “node” represents a process to 
be completed. These processes will become individual production tasks that will be assigned to artists and 
supervisors.

There are four types of workflows: Job workflows, Scenes workflows, Asset workflows and Task Status 
workflows.

For example, you may use a job workflow to track an episode’s development from script to delivery however 
you would use a scene workflow to track the production of shots from layout to compositing while the asset 
workflow is designed to handle the evolution of various assets such as backgrounds, characters, props, etc. 
The task status workflow is somewhat special because it allows the user to customize the task statuses for 
the processes of the other workflows.

Producer comes with some ready-made workflows, however it is recommended that you use these as 
templates to create your own. Workflows are specific to projects, however they can be exported and imported 
from one project to another.

Workflows are blueprints to eventually create actual tasks that can then be assigned and tracked.
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Task Status Workflows
A task status workflow has a particular property. It's a workflow that can be applied to the task of another 
workflow. It provides different statuses for that task, letting users know the progress of that task.

NOTE 

To find out how to link a task status workflow to a task—see Configuring Processes.

In the Basic Task Status workflow (a workflow that comes with Producer), there are seven possible options: 
Standby, Pending, Need Assistance, In Progress, To Validate, Revise, Approved.

In the Production or Assets > Manage tab, when a user clicks on a task status, a drop-down menu lets them 
choose or update the status of that task.
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Included Workflows
Here is the list of workflows that are included with Producer, along with a brief description for each.

Episodes

Workflow to track jobs such as episodes of a TV series.

Basic

Workflow to track scenes in a simple manner.

Complete

Workflow to track 2D paperless scenes, where the animation is hand-drawn digitally.

Double Approval

Workflow to track scenes, where the two approval stages are required for each necessary step in the process.

Single Approval

Workflow to track scenes, where a single approval stage is required for each step in the process.

BG

Workflow to track the creation of bitmap backgrounds.

Character 
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Workflow to track the building of digital puppets (also known as character rigs).

Prop

Workflow to track the building of digital props.

Basic Task Workflow

Basic Workflow providing statuses for the tasks of the other workflows.

Simple Task Workflow

Simple Workflow providing statuses for the tasks of the other workflows. It is meant to track something that is 
completed without any type of revision or approval (ie: task done).
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Approval

This workflow provides typical statuses for approval processes.
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Duplicating Workflows
The workflows that are provided with Producer are useful templates to create your own. It is NOT 
recommended to use them directly as they may be updated and modified in future versions. Instead, duplicate 
and modify them to match your own pipeline.

How to duplicate workflows

 1. In the main menu, select Settings and then Workflows.

 2. In the Project Workflows list on the left, click on the workflow you wish to duplicate and select 
Copy from the ellipsis menu (“...”).

The Copy Workflow Details dialog box opens.
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 3. In the Name field, enter the name of the new workflow.

 4. In the Colour field, use the colour picker widget to select an identification colour.

 5. Click Create.
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Creating Workflows

How to create a workflow

 1. In the main menu, select Settings > Workflows

The Workflows tab opens.

NOTE 

If the Settings or the Settings > Workflow options are not available, an admin user 
may have to grant these privileges to a group that you are a member of. This can be 
done in Security, under Global Rules, by enabling Manage Workflows.

 2. Click on the Add Workflows button.

The Add Workflows dialog opens.

 3. In the Name field, enter the name of the new workflow.

 4. In the Type drop-down menu, select the type of item to which this workflow applies. For workflow 
of episodes, select Job. For a workflow tracking shots, select Scene. For a workflow of 
backgrounds, characters or props, select Asset. If you would rather create a Task Statuses 
workflow, refer yourself to the section How to create a task statuses workflow.

 5. In the Colour field, use the colour picker widget to select an identification colour. Note that you can 
use the colour picker icon to pick a colour from anywhere on your desktop. After your colour 
selection simply click outside the widget to proceed.
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NOTE 

It can be a good idea to create a workflow based on an existing one. To do so, use the 
Copy From field (or simply leave it blank to create a workflow from scratch.)

 6. Click Create to create the workflow.

Next, you will want to add Processes to your workflow. Check out the section on Creating 
Processes.
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Processes
A workflow is made of processes. When creating an asset or a scene using a specific workflow, each process 
of this workflow represents a task that can be assigned to users. Processes are ordered in a linear fashion. 
There are 2 main types of processes: Manual and Approval. There is also a special one called Asset Progress.
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Manual

The Manual Process is used when the work is done by a person (ie not an automated task or a simple 
approval). This process can have different statuses which are defined in a Task Statuses workflow. The task 
status is manually changed by the user executing the work.
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Approval

The Approval Process is used when work created during a manual process needs to be reviewed by a 
supervisor. The supervisor will then update the status to Approved or Retake. Several approval processes can 
follow one another.

You can attach triggers and notifications to both Manual and Approval processes so that when a specific 
action is performed, such as assigning a task or status change, another action can be performed, such as 
sending a notification to a user.
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Asset Progress

The Asset Progress special process is used to follow the advancements of assets related to a scene, such as 
backgrounds or characters. The Asset Progress will display a circular graph indicating how many associated 
assets have reached a specific process in their own workflow.
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Adding Processes to Workflows
Workflows are made up of nodes, representing processes, which will eventually turn into tasks.

How to add processes to workflows

Whether you want to add processes to a brand new workflow or modify an existing one, the process is 
the same. You must first select the workflow from the workflow editor.

 1. In the main menu, select Settings > Workflows.

 2. From the left pane, select the workflow for which you would like to add a process.

 3. To create a new Process in a workflow, simply click on the Add Process button.
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The Add Process dialog opens.

 4. Type the name of the process.

NOTE 

Choose the name carefully as process names cannot be changed (to avoid corruption). 
To rename a process, you would have to duplicate it and delete the original.

 5. Select a Process Type from the drop-down list. Check the tooltip for more information on the 
various types of Processes.

 6. Select a unique colour that will help identify this process.

 7. You can set the Position to modify where this new process will appear in the workflow. By default, 
it appears at the end. Note that you can always change this position later.

 8. Press Add.

Check Configuring Processes to learn  how to further configure the process you just created.
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Configuring Processes
Different types of processes can be configured in different ways. However some configuration options are 
available for several types of processes. Here is a descriptions of all the options available:

In the Basic Information area:

Option Description

Name
The name of the process is grayed out as it cannot be changed after the creation. To 
rename a process, you would have to duplicate it and delete the original.

Process Type

You can change the type of process. There are four types of process available: 

Manual process is the most basic. It corresponds to typical assignable artists’ tasks. 
Manual tasks may have target durations or completion dates. 

Approval process acts as milestones for a supervisor to validate work from previous 
tasks. Approval tasks do not have a set duration.

 Asset progress reports when workflows of assets used in a scene are completed. 
They are used in conjunction with Asset Assembly.

Overview processes are available only for job workflow. They provide a cumulative 
overview of the task statuses for all scenes within a job.

Colour

You can set the colour used everywhere to identify this process. The colour selector is 
simple to use. Note that you can click on the dropper icon to pick a colour from 
anywhere on the desktop. You also have the possibility to specify a colour using a 
numerical value. Three modes are available: RGB, HSL and HEX. Simply click outside 
the colour widget area to confirm your choice. The task (which you can view in 
Production and Asset > Manage tabs) associated with the node takes on the same 
colour.

Position
You can set the Position to determine where this process will appear in the workflow, 
the number one position being the leftmost.

In the Task Information area:

Option Description

Task Status 
(Available for 
Manual and 
Approval 
Processes) 

Select a Task Status workflow from the drop-down menu to link it to this Process. 
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Option Description

The Task Status options of that workflow become instantly available as a drop-down menu 
in the sample task above.

.

Assignee Group

Set an Assignee Group to restrict the assignment of these tasks to members of a specific 
group. This is especially useful if there are many users.

Completion
Set a number from 0 to 100 to represent the overall progress of the item (job, scene or asset) 
once this manual task is completed. For example, if a scene is considered 20% completed 
when the layout is finished, set the “Completion” value of the manual process “Layout” to 20.

Duration

Use this field to specify how many days are needed to complete all the tasks of this process 
for the whole job. This will set the default value to calculate the due date for the production 
schedule that can be seen in the GANTT chart. Note that the due date can later be modified 
per task.

Effort
Use this field to specify how many hours a task should typically take. This can be used to 
measure performance and track costs when compared to worked hours. Note that the effort 
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Option Description

can later be adjusted for specific tasks.

Take/Retake

This field will determine whether to keep a track of “Takes" or "Retakes”. For example, a task 
process will typically track a Take number whereas an approval process will typically track a 
Retake number. You can also set the initial Take or Retake value. To determine when the 
Take or Retake number will increment, you will set behaviours. To view the current Take or 
Retake number in the Production page, you will have to edit the column options.

The Asset Progress have different configuration options:

Option Description

Tracked Workflow

Select the workflow of the assets (associated with the current scene) that you would 
like to track. For example, if you would like this “Asset Progress” to report on 
background completion, you should select the asset workflow that you use to build the 
background assets.

Tracked Process

Select the process that the asset should reach to be considered “complete” for the 
purpose of this “Asset Progress” report display. For example, If you would like that an 
asset be considered complete when the Process “BG_Final_Approuval” has been set 
to “Approved”, then select “BG_Final_Approval” as the “tracked process”.
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Moving Processes
There are two ways to change the order of processes.

You can do it by changing the value of position:

 1. In the Workflow Editor, after selecting a workflow in the left pane, select a process that you would like 
to move.

 2. In the Basic Information area, lower the value of position to move the process towards the beginning of 
the workflow (left) or increase the value of position to move the process towards the end of the 
workflow (right).

You can also drag a Process to its new position from its vertical ellipsis:

Both methods require that you save the changes.

NOTE 

Changing the position of a process may affect behaviours that are referring to relative processes 
(Next or Previous process) but will not affect behaviours that are referring to processes by their 
specific names. Be sure to test the various behaviours after changing the position of one or 
multiple processes.
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Deleting Processes
You can easily delete nodes from a workflow by following this procedure.

How to delete processes

Deleting a process from a workflow is a simple operation. You must first select the workflow from the 
workflow editor and then follow these steps:

 1. Select the process you would like to delete.

 2. Click on the ellipsis icon (“...”) on the top right of the process node.

 3. Select “Delete”.

 4. Press the blue “Save” button to confirm.

NOTE 

Deleting a process from a workflow will be reflected in future instantiation. However, it does not 
delete currently existing tasks of this process. If you would like to do that, it is recommended that 
you use the “Edit Tasks” feature prior to deleting the process in the workflow.
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Behaviours
A behaviour determines how a process reacts to certain conditions such as being assigned to a user or being 
set to a certain status. This reaction can be many things and there can be multiple different actions taken as a 
result of one condition being met. In essence, behaviours allow you to automate operations. They are a very 
important part of setting up an effective workflow.

Typical behaviours for a manual process would look like this:

If this process is set to status “To Validate” then set the status of the next (approval) process to “Pending” 
(ready for review).

Before creating a behaviour, you must first create a custom workflow—see Creating Workflows or Duplicating 
Workflows. It is interesting to note that duplicating a workflow will also duplicate its behaviours.

NOTE 

Behaviours used to be called Triggers in older versions of Producer.

How to create a behaviour

 1. In your Workflow, select the process for which you would like to add a behaviour.

 2. In the panel below, click on “Add Behaviour”.

 3. Set up a condition by using the drop-down after “When”. Three possible actions are listed:

 a. Task Status is changed...

 b. Task Status is set to...
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 c. Task is assigned…

 4. If the condition requires further setting, another drop down appears next to the first one. For 
example, if you set “When” to “Task Status is set to…”, you now have to set the “Source Status”, to 
end up with a condition that sounds like “When Task Status is set to To Validate”...

 5. You can now set the Action resulting from the condition being met. Next to “Then”, use the drop 
down to pick one of 3 possible actions:

 a. Set Task Status of Process

 b. Increment (Re)Take

 c. Send Notification to
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 6. Whichever choice you made in the previous step, you now need to further configure that action.

 a. In the case of “Set Task Status of Process”, you now need to specify which process will be 
set to which status. For example, you could specify that the action is to Set Task Status of 
Process Layout_approval to Pending.

NOTE 

When selecting a process, you can either pick a specific process by name or you 
can use a relative process such as Next or Previous process. While relative 
processes can be useful in that they are easier to copy and reuse later with 
minimal maintenance, it is important to remember that moving the process 
around could affect the result of the behaviour.

 b. In the case of “Increment (Re)Take”, you nneed to select which process will increment the 
value of “Take” or “Retake”, depending on which value this process is tracking.

 c. In the case of “Send Notification to”, you can select one or multiple contacts to be notified.  
They can be users or groups of users. The notification can also be sent to the task assignee 
directly.

 7. Now that a first action has been specified, you can either confirm the behaviour with the “Done” 
button or specify more actions to be executed when the above condition is met. To do so, simply 
use the dropdown next to the last “Then” and redo step 5 and 6.

 8. After confirming a behaviour, you can review it by clicking on the right triangle next to the 
Condition.
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The behaviour will expand to display all actions resulting from the condition being met. You can 
then use the blue edit button to make changes or red “x” icon to delete the behaviour.

After reviewing your behaviour, you can add more behaviours to the same process if you want.

NOTE 

Changing the conditions (Status, Assignee) of a process in the upper preview display of 
the workflow editor WILL NOT trigger the actions programmed through the 
behaviours. It is highly recommended that you test your behaviours by creating actual 
items (scenes, assets) using that workflow and changing the conditions to verify that 
the appropriate actions are happening as expected.

To help you get started, here are some typical behaviours for manual and approval processes:

Common behaviours for manual processes:

 l When a task is set to To Validate, then set the status of the next approval task to Pending and 
Increment the value of Take for this process.

Common behaviours for approval processes:

 l When a task is set to Retake, then set the status of the previous manual task to Revise and 
increment the value of Retake for this process.

 l When a task is set to Approved, then set the status of the next task to Pending and set the status 
of the previous manual task to Approved.
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Adding Overview Processes to Job Workflows
While a Job workflow is keeping track of tasks that are relevant to the whole job (such as writing the script or 
generating the storyboard), it is also possible to be informed of the cumulative statuses of scene tasks 
contained within a job by adding “Overview” processes. An overview process will look for scene processes 
with the same name and will summarize the amount of each statuses for convenient display right at the job 
level, providing an overview of the progress in the Task Completion Column of the Production Page.

Task Completion Overview

How to add an Overview Process to a Job workflow

 1. In the Workflow Editor, open up the Scene Workflows containing the Processes you are interested 
in tracking. Identify these processes, noting the exact spelling of their names, the values of 
completion and duration. The colour can also be useful.
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 2. Open the Job Workflow in which you would like to include Overview processes.

 3. Click on the Add Process button
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(The Add Process dialog appears)

 4. Enter the exact same name as the scene process you want to track.

 5. Select the “Overview” process type.

 6. It is a good idea to use the same colour as the process you are tracking.

 7. Click Add to create the overview process.

NOTE 

The new process has two configuration options in the Task Information panel: Completion and 
Duration.                 

 

About Completion:

You should try to adapt the completion value to the context of the whole Job. For example, a 
Layout represents 25% of a scene's workflow. However, completion of all the episode's 
layouts could represent 60% completion if it contains lengthy processes such as scripting and 
storyboarding.

 

About Duration:

You can reuse the same value as was entered in the scene process. This will help to calculate 
the Gantt chart.
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Chapter 4: Production
The Producer structure is divided as follows:

 l Project

 l Environments

 l Jobs

 l Scenes

Environments are a collection of jobs. Typically, environments are used to separate the seasons of an 
animated series, or to separate animation series themselves.

Jobs are a collection of scenes. Typically, jobs are used to separate the episodes of an animated series.
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Creating Projects
Creating a project is the first step to creating and housing environments, jobs and scenes.

How to create a project

 1. In the main menu, select Settings.

The Project Settings are displayed.

 2. In the Project Settings tab, select Project.

The Projects tab opens.

 3. In the Projects tab, click on the New Project button.

The Create a new project window appears.
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 4. In the Title field, enter the title of the project.

 5. In the Project Code field, enter the project code.

IMPORTANT 

The project code is a very important key that will tie many components of the 
project together. The project code must contain only alphanumeric characters 
[A-Z]/[0-9] and only an '_' as a separator.

 6. Click on the Create button.

A status bar appears. When it reaches 100% the Go to New Project and Close buttons appear.

 7. Click on the Go to New Project button.

The project appears.
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Creating Environments
Environments are a collection of jobs, each of which is a collection of scenes. Typically, environments are used 
to separate the seasons of an animated series, or to separate animation series themselves. Special 
environments can also be created to store scenes containing character models and assets for a series.

A new project does not have any environments. To start creating the structure of a project, environments must 
be manually created by a user with administrative privileges. A project can have as many environments as 
needed.

Users with the appropriate privileges can add, edit, retire, and delete environments.

How to create an environment

 1. In the main menu, select Production.

 2. In the Environments drop-down menu, select All Environments.

 3. Click on the Add Environment  button.

 4. The Create Environment dialog opens.
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 l Name: Type in the name of the new environment.

 l [Optional] Description: Optionally, add a description of the new environment.

 l Add a default thumbnail box: you can optionally drag and drop a file that will be used at 
the environment's Preview image. This can also be done at a later time.

 l [OPTIONAL] Check the Create in Harmony Server checkbox.

 l The Harmony Environment is automatically generated from the Name field but can 
be overridden. If there are spaces in the name, they will automatically be replaced by 
underscores. Harmony doesn’t allow spaces in names.

 l Harmony Version Alias: You can optionally enter a label identifying a version of 
Harmony (See Producer Link Settings page)

NOTE 

Check the Create in Harmony Server option box if you are using 
Harmony Server and want to create or register the environment in 
Harmony database. Do NOT check this option if not using Harmony 
Server.

Refer to Harmony Synchronization section for more information.

 5. Click on the Create Environment button.

The environment appears in your project.
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Creating Jobs
Jobs are a collection of scenes. Typically, jobs are used to separate the episodes or other segments of an 
animated series. 

A new job does not have any scenes by default. To start creating the structure of a job, scenes must be 
manually created by a user with administrative privileges. A job can have as many scenes as needed.

Users with the appropriate privileges can add, edit, retire, and delete jobs, and all users may search, open, and 
view jobs.

How to create a job

 1. In the main menu, select Production.

The Production tab opens.

 2. In the All Environments drop-down menu, select the environment you are looking for.

 3. Once in the environment, click on the Add Jobs  button.
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 4. The Create Job window appears.

 l Number of jobs: enter the number of jobs you wish to create.

 l Start Date: click on the calendar icon to select a start date for the first job.

 l Days between jobs: If you entered a value greater than one for Number of jobs, enter the number 
of days you would like in the production schedule between jobs. This will affect the production 
schedule Gantt chart.

 l Name: type in the name of the first job.

NOTE 

If you create more than one job, it is important to add a number to the end of the name, 
as the other jobs will use the same name plus subsequent number.

 l [Optional] Description: Add a description of the job.

 l Job Workflow and Scene Workflow drop-down menus: find the job and scene workflows that you 
would like to associate with the new jobs
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 l [Optional] Check the Create in Harmony Server checkbox if you want to create Harmony files 
directly to the Harmony Server (if connected).

 l The Environment field is automatically set from the parent Harmony environment. It can be 
overridden here to point to an alternate Harmony environment, but the environment will not 
be created in Harmony.

 l The Job field is automatically set from the one entered into the Name field. Spaces will be 
replaced by underscores.

 l Harmony Version Alias: You can optionally enter a label identifying a version of Harmony 
(See Producer Link Settings page)

NOTE 

Check the Create in Harmony option box if you want to create Harmony files directly to 
the Harmony Server (if connected). Do NOT check this option if your scenes will be 
created in Harmony Standalone.

 5. Click on the Create Job  button.

Your job page will look something like this:
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Creating Scenes
Once you've created an environment and jobs for your project, you can start to populate your job with scenes.

How to create a scene

 1. In the Production page, from the list of jobs, double-click on the job you would like to create scenes 
for. Alternatively, go to the Jobs drop-down menu and select a job from the list.

 2. Once inside the job, click on the Add Scenes  button.

 3. The Create Scene window appears.
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 l Number of scenes: Enter the number of scenes you wish to create.

 l Name: Type in the name of the first scene.

NOTE 

If you create more than one scene, it is important to add a number to the end of 
the name, as the other scenes will use the same name plus the subsequent 
number.

 l Workflow drop-down: select the workflow you would like to associate with the new 
scenes.
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 l Number of frames: enter a numerical value for the number of frames that you would like 
automatically created for each scene.

 l Priority drop-down: select the priority (No priority, 1 - Critical to 5 - Low) for the new 
scenes.

 l [Optional] Description: optionally add a description for the scene

 4. OPTIONAL: Link the scene to an actual file by selecting one of the three proposed options:

 a. Create in Harmony Server: Link a Harmony Scene asset by checking the box.

Fill in the Environment name, Job name, Scene name and Harmony Version Alias, if 
applicable.

NOTE 

This will create the scene on the Harmony Server, but the Environment and Job 
must already exist in Harmony. If the scene already exists in Harmony, this will 
simply link to that scene.

OR
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 b. Harmony Standalone: Links to a scene from a standalone version of Harmony. Fill in a 
Workspace Alias and Relative Path.

 c. Other: Links to another type of scene from a third party software. 

      

 5. Click the Create Scene button.

The scene(s) are added to your job.
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Editing Tasks
Once a task is created for a given scene or asset, it can easily be modified.

How to edit a task

 1. In the main menu, select either Production or Asset > Manage.

 2. In the Environment, Jobs or Scene drop-downs, select an environment, scene or job or a 
combination.

The tab is populated.

 3. From the list, select the assets  to edit by checking their checkboxes.

 4. In the tab toolbar, select More  > Edit Tasks.

The Edit Tasks window appears.
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 5. In the Task Operation drop-down menu, select one of the following:

 l Add - To add missing tasks to selection

 l Delete - To delete existing tasks from selection

 l Replace - To replace some or all tasks for the selection

 l Shift

 6. In the Selected drop-down menu, change the Workflow type.

 7. In Processes list, check the tasks you wish to include in the Workflow.

 8. Click the Submit button.
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Writing Notes
The Write Notes  feature allows you to create notes on one or multiple scenes that have been selected. 

How to create a note

 1. In the top menu, select either Production or Assets > Manage.

 2. From the drop-down menus, located under the main menu, bring up a list of environments, jobs or 
scenes.

 3. From this list, select which you would like to add notes to by checking their corresponding check 
box.

 4. In the tab toolbar, click on the Write Notes  button.

The Create New Note dialog box appears.
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 5. Check the Link notes option if you want changes in one note to automatically update in the other 
notes for all the assets you selected.

 6. In the Process drop-down menu, select the task/process in the worklfow that you would like to add 
the note to.

 7. Select the retake type (ie: artistic, technical, or both).

 8. In the Note Content field, type in your note.

 9. Click on the Add attachments button if you would like to add an attachment.

 10. Click the Create button.

The note is added to the selected assets.
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Gantt Charts
A Gantt chart is available from the Production page under All jobs of any environment. It can be displayed by 
switching layout type along List and Tiles views.

The Gantt chart lists all current jobs and their tasks for the selected environment. It can be collapsed to have 
an overview of when jobs should start and end over time or it can be fully expanded to display all tasks for 
every job. Every row displays the name, duration (in days), start and end dates for the environment, it’s jobs 
and all tasks from their workflow.

On the right side, there is a timeline and progress bar for each row, it will turn from grey to green when tasks 
start getting approved or completed. There is also a completion % that indicates the progress for each task, 
every job and the environment itself.

If a job needs to be shifted over in time, simply highlight the desired job and click on More in the menu above 
the table, then select Shift Jobs. In the Shift Jobs window, simply select the number of days it will be shifted 
over (jobs can be shifted in the future or in the past, using positive or negative values).
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Scene Focus View
This section provides the details related to a scene (Status, Assignee, Notes, Associated Assets) so that one 
can focus on that given scene  without being distracted by the information of other scenes, as may be the case 
when viewing multiple scenes in the production page.

How to access Scene Focus View

Do one of the following:

 l Double click on a scene row on the Production Page.

 l Select a Scene from the drop-down list in the navigation section.

In order to exit the scene focus view, select "All Scenes from Current Job" from the drop-down list.

 

The Scene Focus view is divided in multiple sections:

Option Description

Navigation
Allows you to select a specific scene to focus. You can also exit the focus 
view, by selecting a Job/Episode in the second drop-down list. Refer to 
Focus View Navigation Section for more information.

Summary
Displays the name of the scene and provides information on the current 
process, its Status and Assignee. It also displays useful information such as 
the overall progress of the scene, the completion of the Assets associated 
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Option Description

with this scene, the current priority and the description.

You can perform the following two actions here:

 l Upload Files

 l Submit for Review

Preview
The Preview of the latest snapshot is prominently displayed and can be 
played back.

Tasks
Below the Preview section, the Tasks section shows all the tasks related to 
the selected scene. It is possible, if you have the rights, to edit the status 
and assignee directly from here.

Related Items

This section is located at the bottom left. It will list any assets associated 

with the current scene. Double-clicking on a line or clicking on the icon 
will bring forth the Focus View for that associated asset. Refer to the 
Associated Asset Focus View section.

Notes
This section is similar to the one you would find in the side panel of any 
Production Page. It will list all the Notes related to the current scene and 
allows you to enter new Notes.

Details
This section is similar to the one you would find in the side panel of any 
Production Page. It will list all the Details of the current scene and allows 
you to edit them.

Harmony 
Settings

This section provides the environment, job and scene name details used for 
the Harmony server integration. The names can be modified using the “Edit 
External Reference” button. 

Focus View Navigation

In the example below, the associated asset Wizard_BG was selected from the Production page’s Daredev_
01_001 scene.

Clicking on Daredv_01_001 will bring the user back to the scene’s focus view.
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Clicking on Daredv_01 will bring the user back to the scene list for that job

Clicking on Daredevil will bring the user back to the job list for that environment

Clicking on the back arrow  will bring the previous level (same as clicking Daredv_01_001)

Selecting the right/left arrows will bring the next/previous asset in the scene’s associated assets.

Associated Asset Focus View

In a Scene Focus View, double-clicking on an associated asset  (or clicking on the open icon) brings that asset’s 
Focus View.

Sections below to add to Asset and Open Tasks

In an Asset Focus View, double-clicking on an associated scene (or clicking on the open icon) brings that 
scene’s Focus View.

In an Open Tasks Focus View, double-clicking on an associated scene or asset (or clicking on the open icon) 
brings that item’s Focus View.

NOTE 

It is not possible to access another level of recursion (ie: double clicking on a scene in an asset 
focus view does not navigate to a Scene Focus View etc).
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Chapter 5: Assets 
Assets are typically any component of a production use to produce scenes and track in Producer. This can 
include character sheets, model references, character rigs, backgrounds, music, and more.

Producer can track the progress and location of all your assets.

Assets can be sorted one of two ways:

 l Categories: Asset categories  are a way of classifying assets based on the purpose of an asset within a 
production, such as characters, backgrounds, props, and more. 

 l Types: Types can be used to categorize the type of file, such as a PNG, JPEG, MOV, MP4, GIF, PSD, or 
PDF.

The following image types are supported for assets: PNG, JPEG, GIF, BMP, TGA, TIFF, PSD, AI, PDF, MP4, 
MOV.
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Interface
An asset has many properties and attributes. By default, the Asset page only displays some information about 
each asset in the asset list.

To display more information on an asset, depending on the type of information you want to see, you may have 
to:

 l Add a column containing this information to the asset list.

 l Select a specific asset, then open either the side panel or the bottom panel to view more information 
about it.

Columns in the asset list can display the following information:

 l Selector

 l Preview

 l Tasks

 l Asset Name

 l Description

 l Type

 l Category

 l Notes

 l Priority

 l Completion
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 l Workflow Code

 l Asset Code

 l Harmony Status

The side panel displays the following information:

 l Preview thumbnail

 l Name

 l Description

 l Priority 

 l Asset Code

 l Notes

 l Harmony Settings: environment/job/scene/harmony version

The bottom panel displays the following information:

 l Tasks

 l Environments

 l Jobs

 l Scenes

The following table lists each type of information about an asset, and which method will display it: 

Information Description Asset List Side Panel
Bottom 
Panel

Preview
The preview thumbnail for the 
asset.

Preview column Side panel N/A

Tasks A step in a workflow. Tasks column N/A Tasks tab

Asset Name The display name of the asset. Name column Details tab N/A

Description The description of the asset.
Description 
column

Details tab N/A

Asset Type
Categories can be used to identify 
the purpose of an asset.

Asset type 
column

N/A N/A
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Asset Category
Types can be used to categorize 
the file type.

Category 
column

N/A N/A

Notes
All the notes that were added to 
the asset.

Notes column Notes tab N/A

Priority
A rank indicating the importance of 
a given asset.

Priority column N/A N/A

Open Harmony

If Producer has been configured to 
synchronize with Harmony, you 
can click this button to open the 
asset directly in Harmony.

Open Harmony 
column

N/A N/A

Completion
A progress wheel tracking the 
percentage of the asset that has 
been completed.

Completion 
column

N/A N/A

Workflow Code
The type of workflow being used 
for the asset.

Workflow Code 
column

N/A N/A

Asset Code  
Asset Code 
column

N/A N/A

Scene Asset 
Code

If a scene has been converted to an 
asset, this is the code of the asset 
it is linked to.

Scene Asset 
Code column

Side panel N/A
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Creating Assets
Upload scripts, characters, backgrounds and 3D models to help visually assist your task workflow.

Users with administrative privileges can create one or more assets at a time.

How to create assets

 1. In the top menu, click Assets > Manage.

 

The assets list opens.

 2. In the toolbar above the asset list, select Create Asset.

The Create Asset dialog box appears.
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 3. Upload a thumbnail for your asset by clicking and dragging your file into the Drop Files Here box.

 4. In the Name field, type in a name for your new asset. It must be unique or else an error will occur. 

NOTE 

It is possible to create multiple assets at once. Press enter after typing an asset 
name and continue entering asset names for all the assets you wish to create 
with the same parameters.

 5. OPTIONAL: Link the asset to an actual file by selecting one of the three proposed options:

 a. Create in Harmony Server: Fill in the Environment, Job, Scene and Harmony Version Alias 
fields to link the asset from an existing Harmony scene.
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NOTE 

This will create the scene on the Harmony Server, but the Environment and Job 
must already exist in Harmony. If the scene already exists in Harmony, this will 
simply link to that scene

 b. Harmony Standalone: Links to an asset from a standalone version of Harmony.

 c. Other: Links to another type of asset from a third party software.

TIP 

An external asset is an asset which is not a Harmony Scene. It can be any type of file, such as 
an image (psd or other), a sound file. Producer only needs to know where that file is located. 
Producer Link may be used to upload snapshots for these assets.
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 6. In the Description field, type in a description for the asset.

 7. In the Type drop-down menu, select what type (3D Model, Image, etc.) of asset you intend to 
upload.

 8. In the Category drop-down menu, select a category (Bg, Main Character, etc.) for the asset type .

 9. In  the Workflow drop-down menu, select your workflow (background, character or prop).

NOTE 

This field is mandatory.

 10. In the Tags field, type any words you would like to associate with the asset that can later be used in 
searches. Hit Enter after typing each tag to validate it.

 11. In the Assembly section, from the Environment drop-down menu, select an environment.

The Jobs drop-down menu is enabled.

 12. In the Assembly section, from the Jobs drop-down menu, select a job.

 13. To save your new assets, click the Add Asset  button.

Your assets are now available in the asset list.
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Searching for Assets
If you have a lot of assets and you need to find a specific asset, you can filter the assets in the list using 
keywords from their descriptions. You can also choose to only view assets associated with specific 
environments, jobs or based on the specific process, status or user they are assigned to. 

How to search for assets using keywords

 1. In the top menu, select Assets > Manage. 

The asset list opens.

TIP 

To include retired items in your search results, in the toolbar above the asset list, 

click  More and, in the pop-up menu, select Show Retired Items.

 2. In the toolbar above the asset list, click in the Quick Search field and type in all or part of the name 
of the asset you would like to find. Hit the Enter key to initiate the search.

TIP 

When an asset is created, the creator had the option to associate certain words 
with the asset (tags)—see Creating Assets. These tags are usually descriptive of 
the asset and can now come in handy when doing a search.

Assets containing your search term appear.

 3. You can repeat this step to add several search terms. Only assets containing all of your search 
terms in their name will appear in the list.
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TIP 

You can restrict your search to assets associated with specific environments or 
jobs by selecting such restrictions from the navigation drop-downs.

How to filter assets by their tasks, statuses and assignees

 1. In the top menu, click Assets > Manage.

The assets list opens.

 2. In the toolbar above the asset list, click on  Toggle Search Panel. 

The search panel appears. 
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 3. From the All Environments drop-down list, select an environment as an asset search filter.

The Jobs drop-down menu is enabled.

 4. Use the Jobs drop-down menu and Custom Fields fields to continue refining your search. If you 
need more filters or a different set, click on the Add button to bring up the Add Processes, Add 
Statuses and Add Assignees drop-down menus. You can use this second set of filters to exclude, 
rather than include, additional information by clicking on the Exclude button.

Use some or all of these filters at your discretion.

You can add several items from any of these categories by clicking on the Add button to create 
another row of the same filters. An example of where this might be useful is when you need to 
search for 2 different processes assigned to the same person. 

 5. Click Apply Search Criteria at the bottom of the search panel.

The assets that match your search appear in the asset list.

How to clear search terms and filters

Do one of the following:

 l Click the  on all search terms in the Quick Search text box.

 l Hit the Backspace key to remove the last search term until all the search terms have been erased.

 l In the toolbar at the top of the assets list, use the Clear All Filters button 

 l At the bottom of the Search Panel, click on the Clear button.

All of the assets within the job are displayed in the asset list again.
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Navigating Assets
The navigation dropdowns (top left of the Asset Manage page)  will let you focus on the assets associated with 
a specific environment or job. These associations are done  either at creation time or through the Asset 
Assembly page. Select the desired environment and job to restrict the display to these assets. 

NOTE 

If you leave the environment to the default “All Environments”, no restriction will apply.

Asset Focus View

To access the asset focus view, simply double click any asset from the list.

Associated Scene Focus View

In an Asset Focus View, double-clicking on a Related Items (or clicking on the open icon) brings that scene’s 
Focus View.
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Editing an Asset
Once an asset has been created, you can edit its description, workflow, and other information at any time.

How to edit the name and description of an asset

 1. In the top menu, click Assets > Manage.

The assets list opens.

 2. In the asset list, click on the check box of the asset you wish to edit. 

 3. If the side panel is not visible, in the toolbar at the top-right corner of the asset list, click the  
Toggle Side Panel button to display it.

 4. In the side panel, select the Details tab.
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 5. To rename the selected asset, in the Name field, type in a new name.

 6. To update the description of the asset, in the Description field, type in a new description. 

 7. To change the priority of the selected asset, from the Priority drop-down menu, select a new 
priority.

 8. To save your changes, click anywhere outside the side panel.

A toaster notification (pop-up) appears in the bottom-right corner of the page, indicating that the 
asset is being updated. When the toaster notification disappears, the asset changes are saved.
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Deleting an Asset
Assets can be permanently deleted. 

NOTE 

Deleting an asset will delete all of its tasks, previews(uploads) and assembly data. Deleted items 
will be permanently lost, and cannot be restored. 

How to delete assets

 1. In the top menu, select Assets > Manage. 

The Asset list opens.

 2. In the Asset list, enable the checkbox on the far left column of the item you wish to delete. 

 3. In the toolbar above the asset list, select More > Delete Assets.
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The Delete Assets dialog box opens. 

 4. In the confirmation prompt, click Delete.

The asset has now been deleted.
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Adding a Preview Image for an Asset
You can add or change a preview image of any asset that appears in the Preview column in the asset list. This 
can be done from either the Assest > Manage tab or the Production tab.

The following image types are supported for preview images: PNG, JPEG, GIF, BMP, TGA, TIFF, PSD, AI and 
PDF.

If you upload a movie clip (MP4 or MOV) as a preview, the first frame of the movie will automatically be set as 
the image. You will be able to play the clip from the Preview column.

For an animated GIF or video file, the first frame will automatically be set as the preview image. You will NOT 
be able to play these files. 

How to add or change a preview image

 1. In the top menu, click Assets > Manage.

The assets list opens.

OR

In the top menu, click on the Production tab.

 2. Use the All Enviroments and/or All Jobs drop-down menu filters to bring up the desired asset(s).

 3. Click the check box of the asset whose thumbnail you wish to change. 

 4. In the toolbar above the asset list, click on the Upload File button.

The Upload File dialog box appears.

 5. Select one of the following options:
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 l This is a default thumbnail to upload an image or movie clip (MP4 or MOV) that will 
be a visual reference for all the tasks in the selected row.

 l This is a preview for the following process to associate an image or movie clip (MP4 
or MOV) with a specific task in the selected row.

When selecting this option, the Process drop-down menu is enabled. Select the task 
you want to associate with the preview image from this list. After the file is uploaded, 
the name of the task will appear near the corner of the thumbnail.

 6. To upload an image, either click on the Click to browse  button or drag and drop the file over it. 

 7. Click the Upload File button.

The selected image/movie clip appears in the Preview column.

TIP 

To view the full-size image/movie clip, click on the Open the image in a new tab 
 icon that appears when you hover over the bottom of the preview image.
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Downloading an Asset Movie Clip
Scene preview movie clips can be downloaded for viewing outside of Producer web interface.

How to download an asset movie clip

 1. In the top menu, click Assets > Manage.

The assets list opens.

 2. If the Preview column is not displayed, in the toolbar above the assets list, enable it from the 
Column selector  button.

 3. Hover your mouse cursor over the Preview thumbnail and click on the gear icon.

A black dialog box appears.

 4. Click on the Download option.

The movie file is downloaded to your computer.
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Viewing Preview Image Versions 
Producer gives you the ability to view  different Preview images and movie clips associated with a certain 
Environment/Job/Scene/Task. 

How to view different versions of Preview images and movie clips

 1. Hover your mouse over a Preview image.

 

A menu bar appears.

 2. Click on the gear icon.

An information and dialog box appears. 

 3. In Process Version, click on the down arrow.

If different image or movie clip options exist, they appear in the drop-down list. Select the one you 
wish to view.

If a Preview images or movie clip was uploaded for the global environment, it has the naming 
convention <default> + version number. If an image or movie clip was associated with a specific 
task during the upload process, it has the naming convention "task name" + version number—see 
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Adding a Preview Image for an Asset. In this example, the movie clip is associated with the Anim 
task and has 3 versions available.

 4. If the image is a still frame from a movie clip, click on the play button to preview the movie clip.

 5. If you would like to see a full-size version of the image or movie clip, click on the Open the image in 
a new tab  icon.
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Replacing Asset Tasks
If your Producer database has several asset workflows, you can change an asset’s workflow by replacing all of 
the asset tasks with the tasks of a different workflow.

How to replace asset tasks

 1. In the top menu, select Assets > Manage. 

The asset list opens.

 2. Ensure the Tasks are visible by doing one of the following:

 l In the toolbar in the top-right corner, click on the Manage Columns  icon, and 
ensure the checkbox next to the Tasks column option is checked.

 l Select the asset in the asset list and, in the toolbar in the top-right corner, ensure the 
Toggle Bottom Panel  button is clicked and the bottom panel is visible. Then, in the 
bottom panel, select the Tasks tab.

 3. Click the checkbox of each asset whose workflow you wish to change.

 4. In the toolbar above the asset list, click on the More  button. 

 5. From the More drop-down menu, select Edit Tasks. 
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The Edit Tasks dialog box appears.

 6. In the Task Operation drop-down menu, select Replace.

NOTE 

All replaced tasks will lose their current assignees and statuses. If you select 
Add instead, missing tasks are added and existing ones are untouched—see 
Adding Tasks .

 7. In the drop-down just below, select the workflow you wish to use.
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 8. By default, all the tasks in the selected workflow will be checked. If you want the selected asset(s) 
to only take some of the tasks in the selected workflow, uncheck the tasks that you wish to 
exclude.

 9. Click the Confirm  button.

A toaster (pop-up) notification appears, indicating that the tasks for the selected items are being 
replaced. When the toaster notification disappears, tasks from old workflows have been removed 
from all the selected assets, and tasks from new workflow have been added.
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Adding Tasks 
When an asset is created with a workflow, all of that workflow’s tasks are added to it by default. It is possible 
to remove specific tasks from an asset’s workflow, as well as to add back tasks that were previously removed.

How to add asset tasks

 1. In the top menu, select Assets > Manage. 

The asset list opens.

 2. Click the checkbox of each asset whose workflow you wish to change.

 3. In the toolbar above the asset list, click on the More  button. 

 4. From the More drop-down menu, select Edit Tasks. 
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The Edit Tasks dialog box appears.

 5. In the Task Operation drop-down menu, select Add.

 6. In the Selected drop-down menu, select the workflow you wish to use.

NOTE 

An asset can only have one workflow, and can only have tasks from its assigned 
workflow. If you select a different workflow than the one that is currently 
assigned to the asset, tasks from the asset’s old workflow will be removed, 
unless a task with the same name exists in the new workflow.

 7. Check the checkbox for each task you wish to add. If you want to add all of the selected workflow’s 
tasks, check Select All.
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 8. Click the Confirm  button.

A toaster (pop-up) notification appears, indicating that the tasks for the selected items are being 
replaced. When the toaster notification disappears, tasks from old workflows have been removed 
from all the selected assets, and tasks from new workflow have been added.
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Removing Tasks
When an asset is created with a workflow, all of that workflow’s tasks are added to it by default. It is possible 
to remove specific tasks from an asset’s workflow, as well as to add back tasks that were previously removed.

How to remove asset tasks

 1. In the top menu, select Assets > Manage. 

The asset list opens.

 2. Click the checkbox of each asset whose workflow you wish to change.

 3. In the toolbar above the asset list, click on the More  button. 

 4. From the More drop-down menu, select Edit Tasks. 
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The Edit Tasks dialog box appears.

 5. In the Task Operation drop-down menu, select Delete.

 6. By default, all the tasks in the asset’s workflow will be checked and marked for deletion. If you only 
want to delete some of the selected asset’s tasks, uncheck all the tasks that you want to keep.

 7. Click the Confirm  button.

A toaster (pop-up) notification appears, indicating that the tasks for the selected items are being 
replaced. When the toaster notification disappears, tasks from old workflows have been removed 
from all the selected assets, and tasks from new workflow have been added.

NOTE 

You can add back the tasks that were removed from an assets workflow—see 
Adding Tasks .
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Retiring Assets
When an asset is no longer needed, retiring it will hide it from view without deleting it. Retired assets can still 
be viewed and reactivated if needed—see Activating Retired Assets.

How to retire assets

 1. In the top menu, select Assets > Manage. 

The Asset list opens.

 2. Click on the asset whose information you would like to view.

 3. Enable the checkbox on the far left column of each asset for which you want to retire.

 4. In the toolbar above the asset list, select More > Retire Assets.

The Confirm dialog box opens.

 5. Select Confirm.

The retired assets is now hidden from view. 
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Viewing Retired Assets 
Assets that have been retired are hidden from the Production page, but can be viewed if needed. 

NOTE 

To retire assets, see Retiring Assets.

How to view retired assets

 1. In the top menu, select Assets > Manage. 

The Asset list opens.

 2. In the toolbar above the asset list, select More > Show Retired Items. 

Retired items appear.
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NOTE 

To hide retired assets, in the toolbar above the asset list, select More. A 
checkmark will be visible beside Show Retired Items. Select Show Retired 
Items to disable it. 

The retired elements are now hidden from view.
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Activating Retired Assets
Assets that have been retired and hidden from view can be restored so they will appear in the asset list. This is 
referred to as activating assets.

NOTE 

To retire assets, see Retiring Assets.

How to restore retired assets

 1. In the top menu, select Assets > Manage. 

The Asset list opens.

 2. In the toolbar above the asset list, select More > Show Retired Items. 

Retired items appear.
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 3. Select the Assets you wish to Activate by using the check box to the far left of the screen. 

 4. Select More > Activate Assets.

 5. In the confirmation prompt, click Confirm.

The retired assets are now visible in the asset list.
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Chapter 6: Monitoring the Workload
Tasks are at the heart of tracking your production with Producer. They can can be automatically created when 
new scenes are added or they can be created manually. Tasks are the practical form of the processes that 
make up workflows.

Tasks have different possible statuses and can be assigned to different users.

Tasks are usually created automatically because workflows have a default setting to automatically create 
tasks. When you create an item, such as a scene or an asset, and you select a workflow using the auto-create 
setting, all the processes of this workflow will be converted into actual tasks for this item.
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Assigning Tasks
Each Task in any Workflow can be assigned to a specific user.

To assign multiple tasks to a particular user you can select one scene at a time and change to the required user 
or use the check boxes on the side of the screen and select the box of  the designated scenes to be assigned. 
and in the Task in the Unassigned drop down menu select the appropriate user. 

How to assign a task

 1. In the top menu, select Production or Assets > Manage.

 2. Select the environment and job containing the scenes to assign.

 3. In the column corresponding to the task, in the Assigned drop-down menu (bottom), set the 
asset/task owner.

 l To assign multiple tasks at the same time, in the left-most column, enable the check box for 
all the scenes to assign and then assign the task owner.
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Checking Open Tasks for Work and Notes
In Producer, every user receives their own unique login credentials. The individual users will have a 
predetermined limit of access to Producer depending on their duties within the animation pipeline. Every user 
will have the ability to check for Tasks and Notes that have been specifically assigned to them in the Open 
Tasks page. 

How to check Open Tasks for work and notes

 1. In the top menu, select Open Tasks.

 2. In the Open Tasks view, use the search toolbar to filter work and update tasks.
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Open Tasks Focus View
This section provides the details related to any scene or asset so that one can focus on that given task without 
being distracted by the information of other open tasks.

To access the asset focus view, simply double click any asset from the list.

Associated Scene or Asset Focus View

In a Scene or Asset Focus View, double-clicking on a Related Items (or clicking on the open icon) brings that 
scene or asset Focus View.
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Updating Status Manually
In the Production, Open Tasks, and Assets views, you can set the status for various tasks.

How to update a status

 1. In the top menu, select Production, Open Tasks or Assets > Manage.

 2. Select the environment and job containing the status to update.

 3. In the column corresponding to the task, in the Status drop-down menu (top), set the asset/task 
status.

 l To set multiple statuses at the same time, in the left-most column, enable the check box for 
all the scenes to update and then set the new status.

NOTE 

You can change it depending on the workflow of the production 
and your need within that workflow. Depending on how the 
workflow is set up there could be some triggers involved with 
other statuses. 
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Logging Work Hours
Producer allows users to track work by hours. In the Open Tasks view, a user can log the hours worked on 
each task on specific dates.

How to log work hours

 1. In Open Tasks, click on the Work Hours tab at the top of the task window. 

The Work Hours window opens.

 2. Here you can select a number of options. 

 l In the Date Range field, select the date range.

 l Use the Search toolbar to search for a particular task.

 l Enable or disable the Hide Approved option to hide all approved work.

 l For each task, enter the number of hours worked in the corresponding day field.

 3. When finished, select Done.
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Uploading and Updating Snapshots 
If Producer is not integrated with Harmony or any other option updating the task snapshot automatically, a 
user can manually upload a snapshot.

If Producer is integrated with Harmony, you can push the asset snapshot automatically from Harmony using a 
script.

How to upload a snapshot manually

 1. In Open Tasks, check the box on the far left for the scene(s) you wish to upload a image or video.

 2. Select Upload File. 

The Upload Preview window opens.

 3. In the Upload Preview window, you can either drag and drop your new preview or click and upload 
it. 

 4. Select Upload.

 5. In the Image area, select the Gear icon that appears when you hover your mouse over the window. 

A new window opens. 
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 6. Here you can view the old preview and the new one. Producer automatically makes the latest 
upload the default preview. 

How to upload an Asset snapshot from a Harmony scene

 1. In Harmony, select the Asset Snapshot script within the asset scene you wish to upload. 

A new window opens. 

 2. The window may display an error at first because it associates the scene name as an asset. Enter in 
proper asset name. 

Harmony then communicates with Producer to recognize the Process you have in place. 

 3. Set your Process and set your Status (keep the box to the left checked). 

 4. Click OK.
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A new window will open showing the progress in Rendering Preview.

 

The Preview Confirmation dialog box opens. 

 5. Select Upload.  

A confirmation window opens.
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NOTE 

If you view your asset in Producer, they will have a Harmony icon in the preview 
window linking directly to the original Harmony file. 
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Verifying a User's Workload
You can filter the Production and Asset lists to see tasks assigned to a user.

How to filter the production table

 1. In the top menu, select Production or Assets > Manage.

The Production page opens. 

 2. Select the Environment for which you want to see the workload and assignments. 

 3. Click on the Toggle Search Panel  button at the top. 

The Custom Fields window opens.

 4. Click the Add + option to add more custom fields as well as use the existing fields to Exclude any 
of the selections.

 l In the Add Processes menu, depending on the workflow you selected you get a drop 
down window similar to this:

 l In the Add Statues, depending on the workflow you selected you get a drop down 
window similar to this:
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 l And in the final drop-down, Add Assignees, it is limited to the users assigned for  this 
particular production.

 5. When ready, select Apply Search Criteria in the bottom right corner of the window.

NOTE 

There is no limit to the amount of filters you can Add or Exclude from your 
search criteria.
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This search is not limited to just one episode. You can put your search criteria to include across all 
episodes within this production.
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Creating Custom Fields
Custom Fields are fields or columns that can be added by user profile to match something they want to track 
that Producer isn’t tracking by default, ie: Difficulty of a scene.

How to create custom fields

 1. To add a custom field click on the More tab and select Add Custom Fields.

The Add a Custom Field window opens. 

 2. In the Name field, enter the name of the new custom field.

 3. In the Description field, you can add an optional Description. 

 4. Click Create.

 5. Open the Field Selector, and check the new custom field.
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 6. To modify the new custom field, select the scene or asset for which you wish to edit the custom 
field value.

 7. Open a side panel and select Details > your custom field.

Your entry now appears in the custom field. 

NOTE 

Everyone in the production will be able to view the custom field. Only certain 
users will have the ability to add them.
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Searching in Producer
In Producer there is a Quick Search located in the Production, Open Task, Assets and Review views. This can 
be used to quickly find a environment, scene, asset, or numerous other items. 

How to search in Producer

 1. In the Quick Search field, type a keyword to filter the production table.

 2. When done, beside the search field, click the Clear Filter  button.
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Chapter 7: CSV Import and Export
Import CSV files in Toon Boom Producer to automatically create empty assets, scenes, jobs, and environments 
and populate additional fields such as Description, Name, and, Note.

Export CSV files from Toon Boom Producer to gather information such as asset lists and details.
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Creating a CSV File
Before creating your CSV file, review the notes below:

 l When creating the data in the spreadsheet application, set numbers with padding as Text format to 
preserve the preceding zeros.

 l You are responsible to avoid doubling the asset and scene names in your spreadsheet. Producer will 
not accept duplicate names and will suggest skipping the problematic entries.

 l 2-bit characters and special characters can be imported via CSV file upload only. It will not work by 
copying and pasting data directly in the Producer Import CSV dialog box.

 l Create your CSV file as a UTF-8 format (8-bit Unicode Transformation Format) to support special 
characters.

 l When creating a sample header row for your columns, use the exact Producer column name to 
automatically match the data. You will be able to reassign the columns directly in Producer before 
completing the import process. Use name in lowercase for the scene or job name to be assigned to the 
Name column.

 l To create scenes, you need to add a column containing the matching Job code. For more information, 
see Displaying the Environment and Job Codes.

 l To create jobs, you need to add a column containing the matching Environment code. For more 
information, see Displaying the Environment and Job Codes.
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Exporting CSV File
Producer allows you to export/import data through CSV files.

How to export a csv file

 1. In the main menu, select Production. 

 2. From the Environment and Job drop-down menus, select an environment and job. 

 3. In the list of scenes, select  one or several  scenes from which you would like to export notes by 
checking their respective checkbox.

 4. In the Production tab toolbar, select More > Export CSV.

The Export CSV window appears.
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 5. Check or uncheck the column checkboxes to select which categories you would like to appear in 
your exported CSV file.

 6. Click Export CSV.

A CSV file automatically downloads.
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Displaying the Environment and Job Codes
When creating a CSV file to create scenes or jobs, you need to include the job code, in which these scenes will 
be created or the environment code, in which the new jobs will be.

How to display the Environment code:

 1. In the main menu, select Production.

 

 2. Use the Environments drop-down menu, under the main menu, to navigate to an environment list.

 3. In the Production toolbar, click on the Column Manager  icon.

 4. In the Column Manager, enable the Environment Code column. 

The Environment Code column appears in the list of environments.

How to display the Job code:

 1. In the main menu, select Production.
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 2. Use the Job drop-down menu, under the main menu, to navigate to a job list.

 3. In the Production toolbar, click on the Column Manager  icon.

 4. In the Column Manager, enable the Job Code column. 

The Job Code column appears in the list of jobs.
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Uploading a CSV File and Copy/Pasting Data
When your data is ready, you can import it in Producer. You can also copy and paste your data directly from 
your spreadsheet to the Producer Import CSV dialog box without creating a CSV.

How to upload a CSV file or copy data from a CSV file:

 1. Go either to Assets > Manage.

  

Or navigate to the Environment, then to the Job where you want to create items from your CSV 
data. 

 2. Click on the More tab and select Import CSV.

 

The Import CSV dialog box opens.
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 3. In the Import CSV dialog box (if a CSV is already created), click on the Select a CSV file to parse  
button and browse for your CSV file. Alternatively, you can paste it into the Copy and Paste from a 
Spreadsheet area.

 4. Set up your String Delimiter to Auto detect. 

 5. Click on the Next: Data Mapping button.

 6. Click on the Next: Verify button.
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NOTE 

If the CSV file format doesn’t match the default value, Producer will display a 
warning.
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Chapter 8: Assembly 
Assembly is the process of associating assets with environments, jobs and scenes that require those assets so 
as to track which assets must be completed before work on these environments, jobs and scenes can begin. 
An asset can be assembled with as many environments, scenes and jobs as needed, and environments, jobs 
and scenes can be assembled to as many assets as needed.

Whether you associate an asset with a scene, job or environment can depend on how much it is used. For 
example:

 l If an asset will only be used in one or a couple scenes in an episode, it makes sense to assemble it with 
each scene in which it is used.

 l If an asset is to be used throughout one or a few episodes, it makes sense to assemble it with each job 
representing each episode in which it is used.

 l If an asset will be used throughout an entire season or an entire series, it makes sense to assemble it 
with each environment in which it is used. 

Assets that have been assigned to scenes can be viewed from the Production page. In the Job Tasks column 
for a given scene, the progress process wheel will display the number of assets assigned to it in the centre, 
and the completion percentage in the wheel. 

The Assembly page also allows you to search and filter assets.
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Navigating and Searching the Production List
The left area of the Assembly page is where you can navigate your production to locate the right environment, 
job or scene, and the right area of the page is where you can browse through and search for assets.

The first step to assembling is browsing through the Production List panel to find the item you want to 
associate assets with.

How to search the production list

 1. In the top menu, select Assets > Assembly.

The Assembly page opens and the Production List panel appears to the left. 

 2. In the Production List panel, navigate to the production item with which you want to assemble 
assets:

 3. To assemble assets to an environment, in the environments drop-down in the Production List 
panel, select All Environments.

 4. To assemble assets to a job, in the environments drop-down menu, select the environment 
containing the job you want to assemble assets with. 
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 5. To assemble assets to a scene:

 l in the environments drop-down menu, select the environment containing the scene you 
want to assemble assets with.

 l In the Job drop-down menu, select the job containing the scene you want to assemble 
assets with.
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 6. To filter the listed items based on keywords, in the Quick Search text box, type in all or part of the 
name of the environment, job or scene you want to find. Then hit the Enter key to add what you 
typed to your search terms.

Only items containing your search term appear in the list.

NOTE 

You can repeat this step to add several search terms. Only items containing all of 
your search terms in their name will appear in the list.

You can remove a search term by clicking on the Close  icon in the search 
terms box. You can also press Backspace to delete the last search term.

 7. To list all items again, do one of the following:

 l Click the Remove  icon on all search terms in the text box or hit the Clear all filters  
button.

 l Press the Backspace key to remove the last search term until all the search terms have been 
erased.
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Browsing and Finding Assets
The second step to assembling assets with environments, jobs or scenes in your production is to find the 
assets you want to associate to the items in the Production List. 

When you open the Assembly page, the list of all the assets for your project is displayed in the right area, in a 
panel labelled Assets List. If you don’t have a lot of assets, you can simply scroll through your assets and find 
the assets you want to assemble. Otherwise, you can use the extensive set of search and display options to 
find the right assets. 

It is also possible to have several lists of assets in the Assembly page, each one taking a part of the space 
reserved to the assets list. Each list can have its own unique search filters and display settings. 
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How to change the size of thumbnails in the assets list

 1. In the top menu, select Assets > Assembly.

The Assembly page opens. The Asset List panel appears to the right.

 2. Ensure the Asset List is in tile mode by clicking the Tiles icon.

 3. To change the size of the assets:

 4. Click and hold the icon in the middle of the slider, then drag it to the left to make the icons smaller, 
or right to make the icons larger.
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How to change the display mode of the assets list

 1. In the top menu, select Assets > Assembly.

The Assembly page opens. The Asset List panel appears to the right.

 2. Do one of the following:

 l To view the Asset List in tile mode, click Tiles.

 l To view the Asset List in list mode, click List.

How to filter assets in the assets list

 1. In the top menu, select Assets > Assembly.

The Assembly page opens. The Asset List panel appears to the right.

 2. In the top-right corner of the Assets List panel click the Toggle Search Panel  icon.

The search panel appears below the toolbar.
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 3. Do one or several of the following to filter the list of assets to the assets you want to assemble:

 l In the Name field, type in the name, or part of the name, of the asset you are searching for.

 l In the Workflow drop-down menu, select the workflow associated with the asset you are 
searching for. 

 l If the asset you are searching for was already assembled with an environment, in the 
Environments drop-down menu, select the environment the asset you are searching for is 
associated with. 

 l If the asset you are searching for was already assembled with a job, in the Jobs drop-down 
menu, select the job for the asset you want to search for. 

 l If the asset you are searching for was assigned a specific process, in the Process field, select 
the process assigned to the asset you are searching for. 

 l In the Statuses field, select the status for the asset you want to search for. 

 l In the Categories field, select the category for the asset you are searching for. 

 l In the Types field, select the type for the asset you want to search for. 

 4. Click Apply Search Criteria at the bottom of the search toolbar.

The assets that match your criteria appear in the list of jobs. 

 5. To display all assets again, click the Clear button at the bottom of the search panel.

All of the assets are now displayed in the asset list.

How to add an assets list

 1. In the top menu, select Assets > Assembly.

The Assembly page opens. The Asset List panel appears to the right.

 2. At the top of the Asset List, select Add Assets List. 

An additional asset list appears on the right. 
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 3. To rename an asset list, click anywhere at the top of the list around the current name.

The text box can now be edited.

 4. Type in a new name for the asset list in the text box, then click anywhere outside of the text box.

The asset list has now been renamed. 

How to remove an assets list

 1. In the top menu, select Assets > Assembly.

The Assembly page opens. The Asset List panel appears to the right.

 2. If there is more than one asset list, click on the Remove  icon to the top left of the asset list you 
wish to remove.

The asset list has now been removed.

How to remove all extra assets list and reset the first assets list

 1. In the top menu, select Assets > Assembly.

The Assembly page opens. The Asset List panel appears to the right.

 2. If there is more than one asset list, select Clear Assets Lists  at the top of the Asset List page.

All but the original asset list are removed.
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Assembling
You can assemble assets by associating assets with the environments, jobs, and scenes in which they are 
used. If an asset is only used in a few scenes, it can be assembled to those scenes; if it is only used in a few 
episodes, it can be assembled to said jobs; if it will be used throughout an entire series season, it can be 
assembled to an environment.

How to assemble one asset at a time

 1. In the top menu, select Assets > Assembly.

The Asset List opens.

 2. Locate the environment/s, job/s, or scene/s you want to associate the asset to from the production 
List—see Searching Production List.

 3. Locate the asset you want to associate to an environment, scene or job from the Assets List. 

 4. Click the asset you wish to assign, and drag it over to the Asset Drop column to the item you wish 
to assign it to.

The asset is now listed in the Asset Drop column.

How to assemble multiple assets at once

 1. In the top menu, select Assets > Assembly.

The Asset List opens.
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 2. Locate the environment/s, job/s, or scene/s you want to associate the asset to from the production 
List—see Searching Production List.

 3. Select the item by checking the checkbox on the far left column of each item you wish to associate 
the asset to. 

 4. Locate the asset you want to associate to an environment, scene or job from the Assets List. 

 5. Select the asset by enabling the checkbox on the far left column of each asset you want to 
associate to an item. 
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 6. Click the Move button to associate the assets to the items.

The assets are now listed in the Asset Drop column.
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Disassembling
Assets that have been associated with environments, jobs and scenes can be disassociated at any time by 
disassembling them. 

How to disassemble assets

 1. In the top menu, select Assets > Assembly.

The Asset list opens.

 2. In the Assets list, locate the environment, scene or job you want to disassemble.

 3. In the Asset Drop column, click the Remove  icon on the asset you want to disassemble.

The asset is removed from the Asset Drop column.
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Checking the Asset Progress in a Scene Workflow
From a scene workflow, you can check the asset creation progress by adding a Progress process. This node 
will track the percentage of completion of the assets assigned to the scene.

How to add a Progress node to a workflow

 1. In the top menu, select Settings. 

The Project Settings are displayed.

 2. Select Workflows.

The Workflow tab opens.

 3. In the Workflow list, select the desired workflow you would like to add the Progress node to. 

The workflow appears in the editor. 

 4. Click on the drop-down arrow BESIDE the Add Process button.

 5. Select Add Progress.
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The new node is added to the workspace. 

NOTE 

Producer reads everything linearly, so the new node must be placed to the left of 
the Workflow.

 6. Rename your node to reflect the purpose, In this case, Asset Check. 

 7. 
NOTE 

To rename any node, either right-click and select Rename or press Ctrl/Cmd Click on 
the node. 

 8. Select the Asset Check progress node.

 9. In the Properties view's Listen to events from field, select the Asset or any type of element you 
would like this to track in your workflow. You can track multiple items. 
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 10. To save the changes to the process, click the Save button.

 11. To save the Workflow, click the Save Workflow  button.
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Chapter 9: Harmony Integration
Producer can be used independently from other Toon Boom software. However, there is a high level of 
integration possible for a studio using Harmony as an animation software and even more so when using 
Harmony database.

This chapter will cover the aspects of Producer integration with Harmony, with a special focus on 
synchronization between Producer and Harmony database, assembling assets into Harmony scenes (aka 
Baking) as well as the increasingly popular setup to work remotely. A specific section is dedicated to Producer 
Harmony Scripts, covering their general interface and usage scenarios (Working with Database, offline or 
standalone scenes).
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Working with Harmony Database

NOTE 

This section is intended for more advanced users (administrators and power users) who can 
configure Harmony Server and have advanced permissions in Producer.

This section describes how Producer inter-operates with Harmony Database, and the various integrations 
available to the users.

The following topics will be discussed:

 l How Producer and its components interact with Harmony.

 l How to configure Harmony (WebCC) to work with Producer.

 l Harmony-Producer synchronization features

 l assembling (baking) assets into Harmony scenes

You may also have a look at the following topics:

 l Working from Home

 l Harmony Scripts
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Topology
For Producer to inter-operate smoothly with Harmony Server and its users, we will need to configure the 
following  applications.

 l Producer (in the cloud)

 l Harmony Server (at the studio)

 l WebCC (at the studio)

 l Producer Link (on the users’ machines, at the studio or at home)

 l Harmony Client (on the users’ machines, at the studio or at home)

The applications involved in the exchange process are the following:

Producer: A web based application usually hosted in the cloud. It acts as a one-stop interface to keep track of 
the production while at the same time synchronizing with Harmony Server. Users are typically making 
requests through Producer web interface. Producer then handles requests and communicates with Harmony 
Server.

Producer Link: Installed on the users’ machines, this desktop application is a complement of the Producer web 
application. It is used to perform operations that are not permitted by a web application (any tasks requiring 
direct access to edit local files, such as decompressing a file). We also use Producer Link to configure 
workspaces (used by Harmony Scripts as well as for uploading assets to Producer), or set up exchange folders 
when working remotely.

Harmony Server: Located at the studio, Harmony server hosts the Harmony Database. It communicates with 
Producer via a communication queue between Producer and Web Control Center (WebCC).
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WebCC: Installed at the studio, WebCC handles all communications between Producer and Harmony. 
Communication with Producer is handled via a dedicated message queue. Messages are posted to this queue 
and processed asynchronously, so that no operation becomes blocking. WebCC needs to be started with 
specific configuration options to communicate with Producer, for synchronization operations, assembly, as 
well as for remote (Working From Home) setups.

Harmony (Client): Installed on the users’ machines, Harmony is used to work on scenes. Harmony Scripts 
bundled with Producer can be installed to update a scene state in Producer directly from Harmony. When 
working remotely, Harmony Scripts also take care of uploading the scene changes back to the server.
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Configuring WebCC
In order to perform operations in Harmony, Producer needs to establish a communication channel with 
Harmony Web Control Center (WebCC).

Communication between Producer and WebCC is done through a message queue which is configured in 
Producer. In short:

 l Producer sends a message (such as creating a scene) to its outgoing queue to WebCC.

 l WebCC, which monitors that queue, reads the message, and proceeds with the command. Once 
completed, it sends the result of the operation to a response queue, which is monitored by Producer.

 l Producer reads and processes that response (for instance, it may send an update to Producer Web 
interface to inform the user that the requested operation has completed)

In addition, WebCC will require workspaces to be configured in order to assemble assets into scenes. 

When Working Remotely.

Please note that when Working from Home, an Exchange Folder will also need to be configured.

WebCC startup options

NOTE 

This section only describes WebCC configuration options related to Producer.

For information about how to configure and start WebCC, refer to Harmony Documentation 
WebCC Installation Guide.

Option Description

-producerAMQP <WebCC Queue>

Address of Producer message queue (can be found in 
Producer top right menu > General Settings > WebCC 
Queue

 a. Copy the “WebCC Queue” address (use the 
“Copy to clipboard” icon ). 

 b. Add this to WebCC startup options, e.g: -
producerAMQP 
amqs://xyz:abcd@mystudio.producercloud.io

-producerCodes <list of producer project codes>

When working with multiple Harmony Databases, add -
producerCodes parameter followed by the list of 
Producer project codes to be associated with the selected 
Harmony instance.
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Option Description

This is a more advanced (and optional) setting which 
requires configuring multiple projects in Producer, where 
each Producer project will write to a specific message 
queue, and each WebCC instance will point to one or 
more Producer projects.

For instance:

 l Harmony Server 1 =>  -amqpUrl 
xyz:abcd@mystudio.producercloud.io -
producerCodes main_project,project_2

 l Harmony Server 2 => -amqpUrl 
xyz:abcd@mystudio.producercloud.io -
producerCodes main_project,project_2

-exchange <path to exchange folder>

The “Exchange” folder is a folder where WebCC will 
deposit exported scenes, and users will upload scenes to 
be updated. 

If not specified, the default location (/USA_DB/exchange) 
will be used. 

It can be useful to change it:

 l when packages are transferred via a shared folder 
(synchronized between the server and the remote 
users) and Producer Offline Scenes setting is set 
to “Exchange Folder”.

 l when space in /USA_DB/ is an issue.

-exportFolder <path to zip folder>

The “Export” folder is a temporary location where 
exported scenes are compressed, and uploaded 
packages are uncompressed before importing the scenes.
 

If not specified, the default location (/USA_DB/zip_folder) 
will be used. 

This option location may be changed if space in /USA_
DB/ is an issue.

-jwtExpiry
When Producer Offline Scenes setting is set to “Direct 
WebCC connection”, determines the time 
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NOTE 

When working remotely, WebCC cannot be started with the -noAuth option.

Workspaces

Producer makes use of workspaces to keep track of production resources locations. WebCC uses those 
workspaces when assembling assets into scenes.

A workspace is typically defined by an alias, associated to a real path on the filesystem.

WebCC reads the list of workspaces from /USA_DB/workspaces.json file, which can be generated manually or 
using Producer Link.
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Harmony Synchronization

How to view Harmony Synchronization status

NOTE 

Harmony Status is available in the Production Page for Environments, Jobs and Scenes, as 
well as in the Assets > Manage page.

In the Table view, go to the Column Selector    and check the Harmony Status box.

This activates the Harmony Status column in the table.

How to create environments in Producer and Harmony Server

 1. Follow the instructions in Production > Creating Environments, and select the “Create in Harmony 
Server” checkbox:

 a. The Harmony Environment is automatically generated from the Name field but can be 
overridden. If there are spaces in the name, they will automatically be replaced by 
underscores. Harmony doesn’t allow spaces in names.

 b. Harmony Version Alias: You can optionally enter a label identifying a version of Harmony 
(See Producer Link Settings page). 
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 2. Click on the Create Environment button.

The new environment will be sent to the WebCC queue for creation.

 3. Go back to the Production > All Environments.

 4. The Harmony Status indicates “Create in Progress”.

 5. Hit the Refresh button or wait for the status to update on its own.

After a while the Harmony Status is updated to VALID. Clicking on the link will display information 
regarding the operation. The new environment now appears in the Harmony Server or will remain in the 
queue until there is a proper connection to the Harmony Server.
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How to add jobs from Producer into Harmony Server

 1. Follow the instructions in Creating Jobs, and select the “Create in Harmony Server” checkbox:

 a. The Environment field is automatically set from the parent Harmony environment. It can be 
overridden here to point to an alternate Harmony environment, but the environment will not 
be created in Harmony.

 b. The Job field is automatically set from the one entered into the Name field. Spaces will be 
replaced by underscores.

 c. Harmony Version Alias: You can optionally enter a label identifying a version of Harmony 
(See Producer Link Settings page).

 2. Click the Create Job button.

 3. The list of jobs is quickly updated (hit the Refresh button if isn’t) while the new job creation request 
is sent to the WebCC queue. All the jobs have a sequential numerical order.

The Harmony Status indicates “Create in Progress” and should quickly change to “VALID”, and 
appear in Harmony Control Center.
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NOTE 

 l Harmony Status will stay in “Create in Progress” until the request has been 
processed by WebCC. The job creation request will remain in WebCC queue 
until a proper connection is established and until processed.

 l In Harmony, Job names are unique.

 l If an error occurs, Harmony Status will change to “FAIL_TO_CREATE” and 
display the reason provided by WebCC.

187



How to add scenes from Producer into Harmony Server

 1. Follow the instructions for Creating a Scene.

 l Check the Create in Harmony Server checkbox.

 l The Environment and Job fields are automatically populated from the parent job 
information. They can be overridden manually, but the environment and job will not 
be created in Harmony.

 l The Harmony Scene name is automatically generated from the one entered into the 
Name field. Spaces will be replaced by underscores.

 l Harmony Version Alias: You can optionally enter a label identifying a version of 
Harmony (See Producer Link Settings page)

 2. Click Create Scene.

 3. The list of scenes is quickly updated (hit the Refresh button if it  isn’t) while the new scene creation 
request is sent to the WebCC queue. All the scenes have a sequential numerical order.

The Harmony Status indicates “Create in Progress” and should quickly change to “VALID”. The 
scenes should also appear in Harmony Control Center.

How to create scenes/jobs in Harmony and synchronize with Producer

NOTE 

Environment and job names must match in both Harmony and Producer for this process to 
work.
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 1. In your Harmony (Control Center or WebCC), create your scenes.

 2. Once the scenes are created in Harmony, go back to Producer and in the main menu, select 
Production.

 3. In the Environment and Job drop-down menus, select the environment and job you would like to 
populate with scenes created in Harmony.

No scenes will be visible yet.

 4. In the Jobs drop-down menu, select All Jobs.

 5. From the list of jobs that appear, select the jobs for which created scenes in Harmony by checking 
their checkboxes.
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 6. In the Production tab toolbar, select More > Synchronize with Harmony.

The Synchronize with Harmony dialog box opens.

 7. Click on the Synchronize button.

The scenes appear in Producer.

NOTE 

Syncing with Harmony will also update the frame counts to those set in Harmony.
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How to sync Harmony with scenes deleted in Producer

 1. Select an environment and job

 2. Check the box on the left column for each scene you wish to delete. Then go to the More tab and 
select Delete Scenes.

 3. The Delete scenes dialog box opens.

Click on the Delete button.

 4. The Delete request is sent to WebCC’s message queue.
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Until it’s completed, the scene list will keep on displaying the scenes with a Harmony Status to 
“DELETE_IN_PROGRESS”. Once deleted from Harmony, the scenes will be deleted from the scene 
list in Producer as well.
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Assembly and Baking
Assembly refers to the process of associating assets to scenes, and then pushing those assets into their target 
Harmony scenes in a process referred to as “baking”.

The first step in Assembly is to build a list of assets and associate those assets with scenes. This is done in the 
Assets > Assembly page.

Then, asset snapshots containing references to the actual asset files on the filesystem shall be uploaded to 
Producer, using Harmony Asset Snapshot Script, or Producer Link’s Upload External Asset or Upload Assets 
CSV.

NOTE 

Producer never keeps the actual asset files on its filesystem. Instead, it takes “snapshots” made up 
of a preview and a reference to these files on the Studio’s filesystem.

Finally, assets may be copied to their associated scenes directly from Assets > Assembly page by opening the 
Harmony Bake dialog (button with the Harmony Logo).

In order to properly assemble assets into scenes, communication with WebCC needs to be enabled, and the 
list of workspaces needs to be defined in /USA_DB/workspaces.json.

Requirements for Baking

WebCC
WebCC is a Harmony application that is able to communicate with Producer. For the 
baking to work, you have to use WebCC version 17.0.3 or higher.  

workspaces.json
Setup manually, the file /USA_DB/workspaces.json specifies which folders can be used 
to store templates and must also specify the folders containing assets so that Harmony 
can find these assets and paste them to the scenes.

How to bake assets into scenes

 1. Create an external asset  — see Creating Assets.

 2. Upload a snapshot of that asset — see Uploading External Assets in Producer Link or Harmony 
Scripts.

IMPORTANT 

A snapshot uploaded directly from Producer’s “Upload File” dialog will not contain the 
information necessary to later assemble that asset.
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 3. Open the Assembly page and navigate to an environment and job’s scene list from the Assembly 
Production list (left pane)

 4. Associate the created asset with one or more scenes — see Assembling.

 5. Select one or multiple scenes to bake.

 6. Press the Bake button

 7. The Bake Assets in Harmony dialog box appears, showing a list of assets to be assembled and 
running a preliminary verification of the assets to be baked.
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Only assets with valid snapshots may be submitted for baking. Pre-flight errors will be clearly 
highlighted. Hovering over the warning icon will provide more contextual information regarding the 
problem.

 8. Click on the drop-down menu to select how you want the asset to be baked.

 l Copy assets to their associated scene’s local library only (Default)

This option makes the asset available within the scene without adding it to the timeline and 
Node view.

 l Always paste assets into the scene itself

This option puts a copy of the asset in the local library of the scene and will add the asset 
directly to the timeline and the Node view. To protect the work that was done and to avoid 
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confusion, this option creates a new version of the scene that will be called “producer paste” 
and this version will become the current version.

NOTE 

The last option that you selected will be set automatically next time you open the 
dialog.

 9. Click on the Bake button.

This will start the baking process.

NOTE 

BAKING CAN TAKE TIME!

Baking consists of two separate operations:

 l Copying asset files into the scenes’ respective libraries

 l Pasting those assets into the Harmony Scene itself

 10. Open the Assembly Logs from the notification Toast.

 11. Click on “View Log” to check the status of the operation.

 12. Follow the progress and status of the operation from the Notification Feed.

Hovering over the status should provide more information about the nature of the error.
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Working Remotely
Working from home is an increasingly popular trend that has advantages as well as challenges. Smooth data 
transfer and proper versioning will go a long way to help maintain efficiency.

When working with a Harmony Database in a studio, the scenes and assets are located on the server and the 
users can edit them directly. With Internet connections varying in quality, this is not practical when working 
remotely and it is best to transfer the scenes or assets locally to work on them with Harmony Standalone.

Producer - along with Producer Link and bundled Harmony Scripts - will play a key role in simplifying the 
process of retrieving a scene to work offline and sending it back to the Harmony Server.

In a remote configuration:

 l Harmony Server handles user requests for exporting/importing scenes and checking scenes in and out 
via WebCC.

 l WebCC handles all communication between Producer and Harmony Server. It responds to export 
requests from Producer by exporting compressed scenes to the users' outbound Exchange folder. It 
responds to import requests from Producer by monitoring the users' inbound exchange folder and 
importing the scene back to Harmony once received.

 l Producer Link handles all operations that need to be performed on the users local machines. It 
responds to Open Scene requests from Producer and maintains a list of already exported scenes. It 
takes care of monitoring incoming exported scenes, uncompressing and opening them in Harmony. It is 
also used to configure workspaces used by Producer Harmony Scripts.

 l Producer acts as a proxy between the remote user machine (via Producer Link and Harmony Scripts) 
and Harmony WebCC.

 l Harmony Client: when working remotely, Harmony will open exported scenes in offline mode, but 
those scenes will still be recognized as “offline database scenes”. Producer’s Harmony Scripts will offer 
additional options to upload the modified scene back to Harmony.

In addition, when working with assets, an assets library folder must also be shared between the studio and 
the user’s machine, so that templates (.tpl) may be saved and later retrieved.
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Configuration
When exporting or importing scenes between Harmony and remote users, two modes are available:

 l Using an Exchange Folder shared between Harmony server and the remote users

 l Using a Direct connection to WebCC

These are configured in Producer General Settings > Harmony Integration.

Using a shared Exchange Folder

In this configuration, all scenes export and import packages are saved to a folder (the “Exchange” folder) 
which is synchronized between Harmony server and the remote users.

This exchange folder can be a shared network drive (using a standard network protocol such as smb, 
preferably over a Virtual Private Network), or using a Cloud storage and synchronization solution (such as 
Google Drive, DropBox…).

NOTE 

In this configuration, the responsibility of transferring / synchronizing the files is delegated to an 
external service.

Harmony Server Exchange Folder:  This folder contains all files being exported from or imported into 
Harmony Database. It contains subfolders with the Harmony usernames of the people exporting and 
importing scenes (username/exported/ and username/importing). These subfolders will need to be shared and 
mounted locally for each remote user.
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This folder exists by default in /USA_DB/exchange, but can be changed to any other folder by setting the -
exchange option in WebCC. It may be shared directly with the remote users, or synchronized to a Cloud 
storage.

Cloud Exchange Folder: When working with an external Cloud storage, this folder contains all imported and 
exported scenes. It is mounted by both the studio and the remote users (any user need only mount their own 
dedicated folder).

Local Offline Folder: This is where exported database scenes are decompressed and stored on the remote 
user’s machine.

To use this configuration set Offline Scenes to Shared Exchange in General Settings > Harmony Integration.

Direct File Sharing

In this configuration, folders are shared directly from the Studio’s filesystem, using standard file sharing 
mechanisms (such as smb).

 l The Scene Exchange folder for exported/imported scenes is by default located under /USA_
DB/exchange. You may consider changing it to a location outside of the /USA_DB folder. Remote users 
shall then mount this remote folder on their machine.

 l Harmony assets library is located by default under /USA_DB/library/assets. Likewise, you may consider 
creating an alternate assets library folder in order to share it with remote users. A workspace shall be 
added in WebCC’s workspaces.json file. Remote users shall mount that folder on their machine and 
add a workspace pointing to that folder in Producer Link Settings. This is only necessary when working 
with Asset Snapshot Scripts.

How to share folders on Windows (an example)

There are many ways to organize and share folders over a network. See File sharing over a network in 
Windows from Microsoft support for detailed instructions.

Consider the following, where administrators decided to locate all shared folders on the D:\Public drive.
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You should minimally:

 l Share the D:\Public\Exchange folder. The Exchange folder is initially empty and Harmony will 
create user folders as it receives export requests.

 l If working remotely with Harmony assets, share the D:\Public\Library\Assets to store asset 
templates.

 l If working with external assets, you may share additional folders (Workspaces)

The shared folders will become available in the network drives:
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Cloud File Sharing

Shared cloud storage solutions can be leveraged to implement the exchange mechanism between the studio 
and the remote users. This setup is suitable for organizations which cannot share their internal filesystems, or 
who are already using a Cloud storage solution as part of their pipeline.

We use Google Drive as an example of how Cloud File sharing may be configured. Other Cloud solutions such 
as Dropbox or Microsoft suite may be used.

A Google Drive application is installed on both WebCC’s side and remote users.

The Harmony server exchange folder needs to be prepared and configured so that remote users can 
synchronize their exported scenes and files via a cloud service. By default, this exchange folder is located on 
the Harmony file system under /USA_DB/exchange. This is where all exported and imported scenes will be 
temporarily stored for every Harmony user.

The default location of the exchange folder can be customized when launching the WebCC service with the 
option -exchange “/path/to/exchange folder”.

Once the Harmony server and WebCC are up and running, it is now time to synchronize the content of the 
exchange folder with a cloud service.

How to share the Harmony Server Exchange Folder on the Cloud

As a studio system administrator, you need to share the Harmony server exchange folder through a cloud 
storage service.

 1. Download and install the Google Drive application on the host of the Harmony server exchange 
folder.
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 2. Using the Google Drive interface, add your Harmony Server Exchange Folder (/USA_DB/exchange) 
to the list of folders to be synchronized with Google Drive.

NOTE 

The exchange folder can either be created within the Google drive file structure or individually 
added to it for synchronization.

Sharing cloud exchange access with individual remote users

When everything is configured server side, a system administrator will need to share access with all 
remote users. It is recommended to specifically and individually share the Harmony user exchange 
subfolder (Cloud Exchange Folder/userName/) and not the full access to the exchange folder itself. This 
will ensure each user only downloads and synchronizes their own files and scenes.

 1. First, the exchange subfolder for every home user needs to be created. This can be done in one of 
two ways:

 a. Manually: You can find the list of Harmony users on the Harmony server in /USA_DB/users/. 
Create these user folders directly under the Cloud Exchange Folder. You should end up with 
a structure similar to this:

Cloud Exchange Folder/

┖  Andres/

┖  Barbara/

┖  Jonathan/

 b. Automatically: When users are exporting a Harmony Database Scene, either through 
WebCC, Harmony Control Center or Producer, the Harmony user exchange folder will be 
created.

 2. From the Google Drive web Interface, select each Harmony user exchange folder (Cloud Exchange 
Folder/userName/) and share it with the appropriate user’s email.

How to mount my Harmony user exchange sub-folder

As a remote Harmony user, you need to mount the Harmony user exchange subfolder that was shared 
with you. You have likely received an email informing you that a system administrator has shared a folder 
with you.
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 l Download and install the Google Drive application on your home computer.

 l Using the Google Drive web interface, find the Harmony user exchange subfolder that your system 
administrator has shared with you (under: “Shared with me”).

 l Right-click on the folder and select “Add a shortcut to My Drive”.

 l Right-click on the folder and select "specify that this folder needs to be accessible offline".

Once the above is completed, you should look into configuring Producer Link to work remotely on a Harmony 
Database .

 l Exchange Cloud Folder/ for exchanging scene contents

 l Cloud Assets folder for asset templates upload

Using Direct WebCC Connection

In this configuration, scenes are exported and imported by downloading or uploading directly from or to 
WebCC.

To use this configuration set Offline Scenes to Direct WebCC Connection along WebCC Url  in General 
Settings > Harmony Integration.

Offline Scenes Direct WebCC Connection

WebCC Url
Specify the url address of WebCC. This address must be accessible to the users working 
remotely, and it is highly recommended that it is used through a Virtual Private Network. 

WebCC must be accessible to the remote users through a secure channel (VPN).

As the responsibility of transferring the files is WebCC’s, it may require a more robust configuration to handle 
the additional load.
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Exporting Scenes Offline
Once the setup for working remotely has been completed, the user has the possibility to initiate the exporting 
and opening of scenes directly from the Producer web interface. If needed, the local desktop application 
Producer Link will open automatically to assist the user in completing the appropriate operations.

The operation of exporting scenes from the Harmony Database can be combined with the actions of checking 
out the scene and opening it remotely. However, you may simply export scenes to prepare them for a later 
usage. 

Scenes may be exported explicitly, by opening the Export Offline dialog from the More toolbar button of the 
Production, Assets, or Open Tasks page or from Producer Link. They may also be exported after clicking on the 
Open In Harmony button  after selecting a scene, if no up to date version of that scene is already present on 
the user’s machine.

NOTE 

Before attempting to export a scene, please be sure that Producer Link is set up correctly. - See 
Setting up the cloud exchange and Setting up Producer Link.

Default Export Options

When exporting a scene offline from the Harmony database, some default options are used to select which 
elements should be exported. These options can be changed for the project from General Settings > Harmony 
Integration > Offline Export Options dropdown. These will be used when exporting a scene from the Open In 
Harmony button   or from Producer Link.

By default, the following options are set:

 l Stage

 l Element

 l Audio

 l Timing

 l Palette

 l Scene Palette

 l Other

Here is a detailed description of each of the options:

Option Description

Annotation The different drawings created while drawing in the Annotation columns.
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Audio The content of the Audio directory.

Element
The contents of the Element directories. (tvg drawings or other file format imported as 
Elements in Harmony)

Timing The contents of the Timing directories.

Stage

The *.xstage, *.aux and other files that are necessary to open the scene. 

IMPORTANT 

This option should always be selected! 

Palette
The PALETTE_List file. The Palette list is a file listing every palette used for the scene and their 
location on the browser.

Scene Palette The palette-library of the scene level.

Job Palette
The palette-library from the job level. When you select the job level, the palette-library in 
lower-level directories will also be exported. Every exported job palette will be placed within 
the folder named palette-library available under sceneName > jobs > Digital.

Env Palette

The palette-library from the environment level. When you select the environment level, the 
palette-library in lower-level directories will also be exported. 

Every exported environment palette will be placed within the folder named palette-library 
available under sceneName > environments > Digital. 

Library Templates created at the selected levels.

Scene Library Templates created at the scene level.

Job Library Templates created at the job level.

Env Library Templates created at the environment level.

Other

All other directories and files in the scene's data structure. For example, some studios will 
place within the scene folder their After Effect, Photoshop or Premiere project used for the 
scene. 

This also includes the scene’s scripts folder, which contains assets’ master controllers.
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Outside 
Drawings

If the Stage option is selected, it is possible to select the Get Outside Drawings option to copy 
drawings into the scene folder that is referred to by the Timing columns and their Element 
(Drawing) nodes.

IMPORTANT 

Do not remove the Stage option as it would not be possible to open the scene afterwards.

These options may be overridden on a case by case basis from the Export Offline dialog (see below).

How to Export a Scene Offline from the Scene List

 1. From the Production page, enter an environment by doing one of the following:

 l Select it from the Environment drop-down list

 l Double click on an Environment

 2. Enter a job by doing one of the following:

 l Select it from the Job drop-down list

 l Double click on a Job

 3. Highlight a scene (by clicking on it)

NOTE 

At the moment, it is only possible to export one scene at a time.

The highlighted scene (the one surrounded by blue lines) will be exported, regardless 
of which scenes are selected via their checkboxes.

 4. Click on the More button and select Export Offline.

206

Producer 22 User Guide                          



Chapter 9: Harmony Integration

 5. (Optional) Modify the export options to suit your needs.

 6. Click on the Export button.
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How to Export a Scene Offline from the Asset List

 1. From the Asset Manage page, Highlight an asset (by clicking on it).

NOTE 

The asset must be synchronized with a Harmony Server.

At the moment, it is only possible to export one asset at a time.

The highlighted asset (the one surrounded by blue lines) will be exported, regardless 
of which assets are selected via their checkboxes.

 2. Click on the More button and select Export Offline.

 3. (Optional) Modify the export options to suit your needs.

 4. Click on the Export button.

How to Export a Scene Offline from the Open Task

 1. From the Open Tasks page, Highlight a scene by clicking on it.

If the scene is synchronized with Harmony, the “Export Offline” button will appear.

 2. Click on the “Export Offline” button.

The Export Offline dialog appears.

 3. (Optional) Modify the export options to suit your needs.

 4. Click on the Export button.
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How to Modify the Export Options

When exporting a scene offline from the Harmony database, the user can select what should be exported 
along with the scene. The user can choose to add elements that may be exterior to the scene itself, such 
as an Environment Palette. Similarly, the user may decide that he does not need everything and choose to 
remove elements from the export.

By default, the export options set in General Settings > Harmony Integration > Offline Export Options will 
be used.

To add export options, click on the downward arrow at the end of the option lists to expand the drop-
down and select all the options you want to add.

To remove export options, click on the “x” next to it.

Analyzing the Outcome of an Export

A Successful export will result is this pop-up message, offering you to open the scene with Harmony:
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More importantly, the Notification Feed will be updated.

For an export to be successful, the following conditions must be met:

 l WebCC service is running (in the studio).

 l Scene, Job and Environment are synchronized.

 l Producer Link’s settings are properly set.

 l The user is connected to the cloud storage application or can access WebCC directly.

Here is a list of the most common issues that could occur following the export of a scene. 

 1. Unfinished export

Until the export is completed, the export will show as “In Progress”.

It is normal that an export request takes time to be processed, especially for bigger scenes and if 
Harmony server is loaded.

Likely causes:

 a. Server is slow and takes time to process the request.

 b. Too many requests are being processed at the same time.

 c. WebCC service is not running

 d. WebCC service is not connected to the Producer queue

 2. Failed Export

A failed export will show up as an error in the notification feed.
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Clicking on the   (log) icon will display a log of the operation, including WebCC log:

Likely causes:

 a. Scene, Job or Environment does not exist in Harmony Database

 b. Harmony Database not available

 c. Database Server (system) error: Disk full, Write permission error, …

 3. Successful Export, but the scene never opens

Likely causes:

 a. While using “Exchange Folder” synchronization mode: WebCC completed the export 
successfully, but the synchronization (uploading file to the cloud or downloading it to the 
remote) takes time or is stalled.

 b. The location of the exchange folder is not properly set on the server or user side.
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Opening Offline Scenes

NOTE 

Opening an offline scene requires installing and configuring Producer Link.

Please refer to Configuring Producer Link and Open Offline Scenes sections.

There are multiple ways to open a Scene remotely.

 l Open directly with the “Open in Harmony” button.

 l Open a scene right after an export via the pop-up message.

 l Open a scene later, using Producer Link. We describe a few scenarios here, please refer to Producer 
Link (Offline Scene) for more complete information.

All these methods will be discussed in detailed How-tos below. Whichever method you use, the “Open 
Offline Scene” dialog of Producer Link will be displayed. 

How to open a Scene Directly with the “Open in Harmony” button

 1. If you have configured your Producer Link  to “Open Scenes in Offline Mode”, the “Open in 

Harmony” button  will behave accordingly. If the scene has already been exported, it will open 
the default version of the latest export. If the scene has not yet been exported, it will proceed to 
export it right away and then, when it becomes available, it will unzip it and open the current 
version.

How to open a scene right after an export via the pop-up message.

As long as the pop-up message of a successful export is not closed, it is possible to open a scene from the 
Open in Harmony button available within the pop-up.

 1. Export a scene offline.

 2. Click on the Open in Harmony button available on the pop-up message or in the Notification Feed:
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The Producer Link Open Offline Scene dialog opens.

WARNING 

Producer displays this message when Harmony informs it that the export request has 
been processed. However, it might take a little while until the exported package is 
actually received in the user’s exported Exchange folder.

Clicking on this button before the export has been received will instruct Producer Link 
to wait for this export before opening the scene.

 3. Open the scene from the Open Offline Scene dialog.

How to open a scene later, using Producer Link

At any time, the user can have access to his exported scenes within the Open Offline Scene dialog of 
Producer Link.

 1. Launch Producer Link.

 2. From the Top Menu, go to Scenes > Open.

The Producer Link Open Offline Scene dialog opens.

 3. Open the scene from the Open Offline Scene dialog.

213



How to open a scene from the Open Offline Scene dialog

 1. In the top section, click on the scene you want to open.

Once the scene is selected, the information regarding the export will be displayed in the lower 
section, allowing various possible actions depending on the status of the scene.

NOTE 

If more than one export has been done for the selected scene, there will be multiple 
rows available in the lower section, the most recent export being listed at the top of the 
list.

 2. Click on the  button to unzip and open the file.
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How to select a particular scene version

Just like Harmony, Producer Link will always show the current version by default. If you would like to 
open a different version, here is the procedure:

 1. Click on the version drop-down.

 2. Select the scene version you would like to open.
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NOTE 

The current database version is indicated by an asterisk (*). The current version will be 
updated when the scene is uploaded back to the database.

How to check out a scene

There are 2 situations in which a user may want to check out a scene.

 l A scene has already been exported but has not been checked out yet.

 l The user is about to request a scene export and would like to check out the scene at the same time.

Both situations are handled in the “Open Offline Scene” dialog of Producer Link.
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 1. In the top section, click on the scene you want to check out.

 2. Choose one of 2 options:

 l Click on the “Request checkout” button to simply checkout the scene:

 l Select “Checkout and Export” from the right-most dropdown button:

=>
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NOTE 

You can change the default value of the Export button to be either “Export only” or 
“Check out and Export”. This can be done in the Settings of Producer Link.

NOTE 

If an error occurs while trying to check out the scene, a warning icon  will appear 
next to the scene name. Hover over the icon to display a more detailed error message.
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NOTE 

If the scene was exported more than once, every export will be listed in the lower 
section. It will be important to look closely at the export date to ensure you are using 
the right one.
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Harmony Scripts
Producer offers a set of Harmony scripts which can be used to upload previews and update tasks status in 
Producer, as well as communicate with Harmony Database.

Those scripts can be downloaded from Producer’s User Guide > Downloads & Resources top right menu.

The same scripts are used when working in Harmony Standalone or Database mode (both on site and 
remotely), with a few variations depending on the usage.

Once uncompressed, the downloaded package contains the following files:

README.md A simple text file that shortly explains the package contents.

TB_Producer_SceneSnapshot.js The main script to use when dealing with a Producer scene.

Scene_Snapshot_Light_Icon.png
A default (light) icon when setting a shortcut in Harmony for the scene 
snapshot script.

Scene_Snapshot_Dark_Icon.png
A default (dark) icon when setting a shortcut in Harmony for the scene 
snapshot script.

TB_Producer_AssetSnapshot.js The main script to use when dealing with a Producer asset.

Asset_Snapshot_Light_Icon.png
A default (light) icon when setting a shortcut in Harmony for the asset 
snapshot script. 

Asset_Snapshot_Dark_Icon.png
A default (dark) icon when setting a shortcut in Harmony for the asset 
snapshot script.

TB_Producer_Snapshot.ui Defines the script layout (required by both Scene and Asset scripts).

220

Producer 22 User Guide                          



Chapter 9: Harmony Integration

TB_Producer_
BatchRenderSnapshot.js

A script used only on Harmony Database side when delegating the 
rendering and uploading the preview to Harmony render farm.

TB_Producer_SnapshotUtilities.js
A utility script (required by both Scene, Asset and Batch render 
scripts).

TB_Producer_NodeSnapshot.js
A utility script (required by both Scene, Asset and Batch render 
scripts).

NOTE 

Producer Harmony scripts use Harmony’s Scripting API whose documentation can be found in 
Harmony User Guide > Scripting section.

Harmony scripts locations can be found in Harmony User Guide > Scripting > Creating Scripts 
section.
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Interface

Login

Producer 
Location

The main address of Producer website 

Producer 
Username

Same username as in Producer Login

Producer 
Password

Same password as used in Producer

Ignore 
SSL Errors

Check only if connecting to an on-premise version of Producer, using self-signed certificates. 
Do not check if connecting to Producer Cloud.

NOTE 

In order to successfully login to Producer from Harmony scripts, you’ll need to first log into 
Producer’s Web Interface from the same machine.

Main Dialog

The general layout of the main dialog is the same, whether we deal with a Producer scene or asset, or work on 
a Harmony Standalone or Harmony Database scene (connected directly to the Harmony Server or working 
remotely).

The following shows the general (and most complex) structure of the main dialog.
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NOTE 

Although Harmony only deals with scenes, one major difference between “scenes” and “assets” is 
that assets are bundled into Harmony templates placed in an asset library to be later imported 
into scenes.

Producer makes a clear distinction between scenes and assets, to facilitate this association via the 
assembly process.

 1. Script name and version: identifies the script being run, and the version of that script:

 l TB_Producer_SceneSnapshot.js for Producer scenes

 l TB_Producer_AssetSnapshot.js for Producer assets

 2. Producer Information
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 a. When dealing with Producer scenes, this section will show three separate fields for 
Producer environment, job and scene corresponding to the opened Harmony scene.

NOTES 

Harmony Database environment, job and scene must match Producer’s to 
automatically match Harmony scene in Producer.

When dealing with a Harmony Standalone scene, the user will be required to 
enter Producer’s environment, job and scene. These entries will be 
remembered next time the script is launched.

 b. When dealing with Producer assets, this section will expose one field, prompting the user 
to enter Producer’s corresponding asset name. The script will remember that asset name 
for the next time it is launched.

 3. Harmony Template Information

This section is present when uploading assets using TB_Producer_AssetSnapshot script.

The user will be prompted to select a workspace, where the Harmony template (.tpl file) shall be 
saved.

NOTES 

The list of workspaces is configured in Producer Link Settings screen. A location to a 
template library is expected to be present in all configurations, whether you’re 
working with a Standalone, Server or Offline scene.

 4. Producer Task Information: This section deals more specifically with updating Producer.

 l “Select Process” prompts the user for their assigned task process. A preview (snapshot) of 
the scene/asset will be generated and uploaded to Producer for that process.

 l (Optional) “Set status to” allows updating the task’s status directly from the script

 l (Optional) “Render half resolution” allows generating the preview at half resolution, for 
faster rendering and previewing (as well as saving space) in Producer

 l (Optional) Work hours: Allows updating hours worked on that task. Work hours will be 
recorded for the current day.

 5. Harmony Database Working From Home options will only be displayed when opening an 
offline (remote) Harmony Database scene.
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 l Upload and Update database scene: Check this option if you wish to upload your work to 
Harmony server. If left unchecked, only Producer will be updated with the preview 
snapshot and task status update.

 l Database scene partial update: When selecting this option Harmony will compare local 
Harmony files to those that were downloaded offline, and only upload the changes to 
Harmony, resulting in a much faster upload.

IMPORTANT 

This option is only available with Harmony >= 22.0.3

Scene is checked out by: Will only be displayed if a scene is currently checked out. The two 
following options are only available if the scene is currently checked out by the current user.

 l Keep the scene checked out

 l Checkin scene

Exchange: This is the location to the Exchange folder (same as Producer Link > Settings > Cloud 
Exchange Folder). Harmony will create a compressed archive containing all scene artifacts to be 
updated in Harmony Database in a user specific folder, which WebCC will grab at the other end.
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How Tos

Locating Harmony Scripts

For Harmony Standalone/Offline:

 l Windows: C:\Users\[username]\AppData\Roaming\Toon Boom Animation\Toon Boom Harmony 
Premium\[version]-scripts

 l macOS: /Users/[username]/Library/Preferences/Toon Boom Animation/Toon Boom Harmony 
Premium/[version]-scripts

 l GNU/Linux: /home/[username]/Toon Boom Animation/Toon Boom Harmony Premium/[version]-
scripts

For Harmony Server, under the following hierarchy:

 l User: /USA_DB/users/[username]/Harmony Premium/[version]-scripts

 l Job: /USA_DB/jobs/[job_name]

 l Environment: /USA_DB/environments/[environment name]

 l Global: /USA_DB/scripts

TIP 

Harmony Scripts locations can be found in Harmony User Guide > Scripting > Creating Scripts 
section .

Installing Producer Harmony Scripts

The following procedure applies to Harmony Standalone or Database modes alike.

In Database mode, it is possible to install the scripts at different levels (Global, environment, job, scene or 
user level). Installing the scripts at a global level will save Harmony users the trouble of installing the 
scripts themselves.

After downloading and uncompressing the scripts from Producer:

NOTE 

An alternative method is to copy the scripts directly into their destination script folder as 
described in the Updating Scripts section below.
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 1. Open a scene in Harmony

 2. In Harmony, under "Windows", open the "Script Editor".

 3. In the Script Editor menu (top left), go to File > Import Script:
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 4. Browse to the decompressed scripts and import the six files.

NOTE 

TB_Producer_BatchRenderSnapshot.js needs only be installed on Harmony server side.

You should answer "User" six times to the question "Where would you like to save ..."

Updating Scripts

If the Harmony scripts have to be updated, you can simply replace the old scripts with the updated ones.
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 1. Locate the scripts for your Harmony configuration (see Locating Harmony scripts)

 2. Uncompress and copy the updated scripts to their destination folder in Harmony.

 3. Click on the “Refresh Script File List” in the Script Editor tab.

NOTE 

Although Harmony offers an interface to delete scripts , it is not possible to delete all 
files, and it is therefore simpler to replace them directly and refresh.

Configuring Shortcuts

After installing Producer scripts, we can set up shortcuts for quick access using Harmony Scripting 
Toolbar.
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 1. Add the script toolbar

 2. Add the TB_Producer_SceneSnapshot & TB_Producer_AssetSnapshot scripts.
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 3. Using the “Customize Icon” feature, upload the provided icons to easily distinguish the two scripts.

 4. The scripts can now be launched from any scene by clicking on the appropriate icons.

After you have completed the work you had to do on a scene, it is now time to render it, submit it for 
approval, log the hours you spent on it and to push the result back to the server (when working with 
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Harmony Database). Fortunately, all of these operations can be combined in one, using the Harmony 
snapshot scripts.

After a standard login procedure, the user will be shown an upload dialog, whose options vary depending 
on the configuration (scene or asset, Harmony Standalone, Database or Remote), while still remaining 
very similar.

However, each scenario here will be addressed independently, so that you may refer to the specific case.

Logging In

When starting either TB_Producer_SceneSnapshot.js or TB_Producer_AssetSnapshot.js script, you will 
first need to login.

 1. Log in to Producer Web interface.

This step is necessary to “register” your machine and allow Harmony Scripts to communicate with 
Producer.

 2. Launch either TB_Producer_SceneSnapshot.js or TB_Producer_AssetSnapshot.js script.

 3. When prompted, enter the address of Producer (eg: https://your-studio.producercloud.io), your 
Producer username and password, then click “OK”

You should now be logged in.

NOTE 

You will not be prompted again next time you open the scripts.

Uploading a Standalone Scene

NOTE 

Ensure that a valid workspace has been set in Producer Link > Settings  page to locate the 
standalone scene’s path relative to that workspace.

 1. Launch the TB_Producer_SceneSnapshot.js script, using the SceneSnapshot icon.
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 2. In “Upload Standalone Scene” section, enter the Producer scene information (Project > 
Environment > Job > Scene), starting with the Project.

NOTE 

An error message will be displayed at the bottom of the dialog if the scene cannot be 
found at the project, environment, job or scene level, and every other field will be 
grayed out, e.g.:

Check the correct information in Producer.

These choices will be remembered the next time you open the scripts (after a 
successful upload).

 3. “Upload Preview to Producer”:

 a. Select the task process and (optionally) the new task status.

 b. (Optional) Select whether to render the preview at full or half resolution.

 4. (Optional) Enter the number of hours worked on that scene (that day).
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 5. Click on the OK button.

The Create Preview progress bar appears.

Once the render is completed, a movie preview opens and a dialog appears.

 6. Click on Upload to send the snapshot (preview) to Producer.

If the upload was successful, you will get a confirmation.
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NOTE 

Producer will process the snapshot in the background in order to generate a web-optimized 
thumbnail and preview.

Once completed, the task will be updated in Producer as well as the uploaded preview.

Provided that the scene workspace has properly been set, the preview details will allow 
reopening that specific version of the scene.

Note that “v2” is the version of the Producer snapshot (i.e.: the second snapshot uploaded for 
that scene process, and not the Harmony scene version).

Uploading a Standalone Asset

NOTE 

Ensure that a valid workspace has been set in Producer Link > Settings page to locate the 
path to the standalone scene relative to that workspace, as well as the path to the output 
template library.

 1. Launch the TB_Producer_AssetSnapshot.js script, using the AssetSnapshot icon.

 2. Login if necessary

 3. In “Upload Scene” section, enter the Producer asset information (Project > Asset Name), starting 
with the Project.
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NOTES 

An error message will be displayed at the bottom of the dialog if the scene cannot be 
found at the project, environment, job or scene level, and every other field will be 
grayed out, e.g.: “Error: Main Project doesn’t contain this asset!”

Check the correct information in Producer (Open Tasks or Assets page).

These choices will be remembered the next time you open the scripts (after a 
successful upload).

 4. “Generate Asset Template”: Select a workspace in the “Workspace” dropdown (The path to that 
workspace is indicated underneath.
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 5. Select the Task process and optional status, choose whether to render the preview at full or half 
resolution.

 6. (optional) Enter the number of hours worked on that scene (that day).

 7. Click on the OK button.

The Create Preview progress bar appears.

Once the render is completed, a movie preview opens and a dialog appears.

 8. Click on Upload to send the snapshot (preview) to Producer.

If the upload was successful, you will get a confirmation.
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NOTES 

Producer will process the snapshot in the background in order to generate a web 
optimized thumbnail and preview.

Once completed, the task will be updated in Producer as well as the uploaded preview.

Provided that the Harmony scene workspace was properly set, the preview details 
will allow reopening that specific version of the asset in Harmony (Note that “v1” is the 
version of the Producer snapshot, i.e.: the second snapshot uploaded for that scene 
process, and not the Harmony scene version).

Provided that the Harmony template library workspace was properly set, the 
template will be found under <template workspace>/<scene name>/<scene_name>[_
number].tpl

Uploading a Harmony Database Scene

IMPORTANT 

When working directly with Harmony Database, scripts may be installed at a global level by 
an administrator. In such cases, users need to configure the shortcut icon directly. Ensure that 
a valid workspace has been set in the Producer Link > Settings  page to locate the path to the 
standalone scene relative to that workspace, as well as the path to the output template 
library.

238

Producer 22 User Guide                          



Chapter 9: Harmony Integration

NOTE 

When working directly with Harmony Database, scripts may be installed at a global level by 
an administrator, or at the user level by the users themselves..An error message will be 
displayed at the bottom of the dialog if the scene cannot be found at the project, environment, 
job or scene level, and every other field will be grayed out, e.g.: “Error: Main Project doesn’t 
contain this asset!”

Check the correct information in Producer (Open Tasks or Assets page).

These choices will be remembered the next time you open the scripts (after a successful 
upload).

 1. Launch the TB_Producer_SceneSnapshot.js script, using the SceneSnapshot icon.

 2. In “Upload Harmony Database Scene” section, the Environment, Job and Scene should be 
automatically populated based on Harmony environment, job and scene
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 3. Set the Process and Status, as well as work hours

 4. Choose whether to Render at full or half resolution

 5. Click OK.

 6. The Create Preview progress bar appears.

Once finished, the Preview Confirmation window opens.

 7. Click Upload to send the snapshot (preview) to Producer.
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 8. Harmony lets you know that your preview has been successfully created.

About “Render Preview using Harmony Server”

When this option is selected, a confirmation message will be displayed immediately after clicking OK 
(step 5).

Harmony will take care of rendering the scene preview, uploading the snapshot to Producer and updating 
the task’s status and work hours.

This operation will be performed according to Harmony render queue priority and the user will not be 
notified of its completion.

Uploading a Harmony Database asset

 1. In Harmony, make sure your Harmony snapshot scripts are installed and launch the TB_Producer_
AssetSnapshot script by clicking on its icon.

The TB_Producer_AssetSnapshot dialog box appears and you may be prompted to login to 
Producer if you are not already.

 2. Complete the login to Producer if necessary.

 3. In the TB_Producer_AssetSnapshot dialog box, from the Project drop-down menu, select the 
project in which you would like to create the template file.
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 4. In the Asset Name field, type in the name of the asset.

 5. In the Process drop-down, select the task/process for which you want to upload this preview of the 
template.

 6. Click on the Set Status checkbox if you would like to set the status of the task/process. If you check 
this box, from the Set Status drop-down menu, select the status that you would like to update the 
status of the task/ process to.

 7. In the Workspace field, select a workspace where the template (.tpl) for the current scene will be 
generated and stored. The workspace is defined in /USA_DB/workspace.json.

If no Workspace is specified, the template will be placed in /USA_DB/library/assets/env_name/job_
name/asset_name.

 8. Click OK.
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A template of the whole scene is generated in Harmony AND preview of the asset is pushed to 
Producer.

Uploading an Offline Scene

 1. Follow steps 1 through 4 of Uploading an Harmony Database scene

 2. Choose Harmony Upload Options

 a. If the scene was checked out by the current user, choose whether to check it in

 b. Choose whether to perform a full or partial scene upload.

NOTE 

Partial upload will greatly improve the speed of the update, especially for bigger 
scenes. It is only available with Harmony 22.0.2 and over.

 c. (Only the first time) Set up the exchange folder path by clicking on the Change button.

TIP 

The exchange path is the same as the one setup within the Settings page of Producer 
Link.

 3. Click OK

Uploading an Offline Asset

 1. Follow steps for Uploading an Harmony Database asset

NOTE 

Make sure that the workspace for the template is shared with Harmony Server..

 2. Choose Harmony Upload Options

 a. If the scene was checked out by the current user, choose whether to check it in

 b. Choose whether to perform a full or partial scene upload.
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NOTE 

Partial upload will greatly improve the speed of the update, especially for bigger 
scenes. It is only available with Harmony 22.0.2 and over.

 c. (Only the first time) Set up the exchange folder path by clicking on the Change button.

TIP 

The exchange path is the same as the one set up within the Settings page of Producer 
Link.

 3. Click OK
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Chapter 10: Reviewing
Reviewing is the process of watching, reviewing, approving, and providing retakes to preview movies for 
scenes submitted by project collaborators after they have completed a task. 

Project collaborators are able upload movie previews of the scenes they have worked on in Producer. By 
loading these movie previews into Producer’s review tool, directors, supervisors, and other project 
administrators are able to do the following:

 l Stitch the movie previews of several consecutive scenes into a sequence.

 l Play these movie previews

 l Stop at, or seek specific frames to examine them

 l Add notes to the scene

 l Draw annotations over frames in the scene, and add them as attachments to a note

 l Approve a scene’s task

 l Send a scene’s task for revisions (retakes)

To use the Review tool, you must create a review session. A session is essentially a container in which you can 
store a sequence of scenes. Opening the session will load the scenes into the Review tool and allow you to 
review and annotate them. 

There are two types of session:

 l Temporary: A review session that is created on the go as you send scenes to the review tool from the 
Production page. Each user can only have one temporary review session. If you already have a 
temporary review session, creating a new one will overwrite the old one.

 l Permanent: A review session that is created in the Review tool before sending scenes to it from the 
Production page. These sessions typically have a specific purpose, such as reviewing the same segment 
of an episode as its completion progresses. You can create as many permanent review sessions as 
needed. 

NOTE 

Reviewing allows you to preview one or several scenes together and is typically used to approve 
the work of project collaborators on tasks or to send them for revisions. If you only wish to watch 
the preview movie for a single scene without actually reviewing it, you can play the preview 
movies for scenes from within the Production page. 
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Creating a Temporary Review Session
Temporary review sessions can be created directly from the Production page. Each user can have only one 
temporary review session at a time, and creating a new one will overwrite the previous one. 

How to create a temporary session

 1. Open the job in which you want to review one or more scenes.

The Scene list opens.

 2. In the far-left column, enable the checkbox for each scene that you want to review.

NOTE 

You can only review scenes that have a playable movie preview. Scenes with a 
movie preview will have a thumbnail and a  Play button underneath their 
thumbnail. 

 3. In the toolbar above the scene list, select Review. 

The Review dialog box opens. 
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 4. In the Select Review Process drop-down menu, select the process (task) that you wish to review. 
This list will change according to the type of workflow that was created. 

 5. Select the Use Temporary Review Session option.

 6. Click Review Now.

A notification will appear in the bottom-right corner of the interface indicating that the session is 
ready. 

 7. Click on Open Review.

 

247



Creating a Permanent Review Session
You can create a review session from the Review page, then populate it with scenes from the Production page. 
You can create as many permanent review sessions as needed.

How to create a session

 1. In the top menu, select Review.

 

 2. In the toolbar at the top of the Review page, select Create a Review.

 

The Create a Review dialog box opens.

 3. In the Name field, name the review session.

 4. In the Date field, select the pop-up calendar and the date at which you want the review session to 
take place.

 5. In Assignee field, you can assign the review to a particular user.

 6. In the Restriction field, select the type of restriction needed to limits the elements that can be 
added to this review. 
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There are three options:

 l Unrestricted: Anything can be added to the session. 

 l Scenes of a Specific Job: It can be limited to scenes of a specific job which opens 
more options (Job and Process).

 l  Assets: It can be limited to assets  which opens one additional option (Process).

 7. To allow external review, enable the External Review option.  This is added as flag as there is no 
limitations while using it. It is useful for a client to easily search for reviews meant for them 
externally. 

 8. Click Add. 

The session has now been created. 

NOTE 

Once your session is created, you must add scenes to it.
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Sharing Review Session 
After a review session has been created, you may want someone else to access it specifically. To do this, you 
will need to make sure the recipient has access to Producer. Please see section on Creating Users.

How to share a review session

 1. In the Review List, under the   of the Actions column, click  icon to generate a Review URL for the 
corresponding review session.

 2. Click on the blue Copy icon to copy the displayed URL to the clipboard.

 3. Send that URL to the remote user whom you would like to review this session.
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Sending Scenes for Review 
Once you have created a session, you can add scenes to be reviewed in it from the Production page. You can 
add scenes to new sessions, empty sessions, or to sessions that already have scenes in them.

How to add scenes to a session

 1. Open the job in which you want to review one or more scenes.

The Scene list opens.

 2. Enable the checkboxes on the far left column of the scenes you wish to review.

 3. In the toolbar above the scene list, click Review.

The Review dialogue box opens.

251



 4. In the Select Review Process drop-down menu, select the process (task) that you want to review.

For example, if you want to review the work of a project collaborator on a scene’s animation, select 
the process for “Animation”.

 5. In the Snapshot Option, choose whether you want to have the latest general snapshot or for the 
specific process that was selected.

 l Latest snapshot: Sends the most recent snapshot, regardless of the process.

 l Latest snapshot of selected process: Sends the most recent snapshot if available. 
Otherwise, it will use the latest snapshot regardless of process.

 l Latest snapshot of selected process exclusively: Sends only the most recent snapshot of 
the selected process and ignores all other snapshots.

 6. You can then select where the snapshots will be added.

 l Override Temporary Review Session: The current user’s temporary session will be deleted 
and the current selection will become the new content of the Temporary Session.

 l Append to Temporary Review Session: Add the snapshots to the end of the current user’s 
temporary session.

 l Use Review Session: Choose an existing review session to send the snapshots to.
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 7. Click Submit to send the snapshots and stay on the current page or Review Now to go straight to 
the Review Tool.

A notification appears in the bottom-right corner of the page indicating that the session is being 
updated. When the notification disappears, the session is ready for review.
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Filtering a Review Session
If you have a lot of review sessions and you need to find a specific one, you can filter the sessions in the list 
using keywords from their descriptions. You can also choose to only view sessions of a certain type, or 
sessions within a specific range of dates.

How to filter sessions

 1. In the top menu, click Review.

 2. In the Review page, click the Toggle Search Panel  button at the top right of the page.

The Search Criteria panel opens.

 3. Select one or many of the search criteria listed. The reviews will automatically populate at the 
bottom as you enter your criteria. 

 4. To remove all of your search filters, click Clear Search Criteria  at the bottom of the search panel.

All of the sessions are be displayed in the session list.
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Editing a Review Session
Once a session is created, you can edit its name, assignee, restriction, date and if the review is external.

How to edit a review session

 1. In the top menu, click Review. 

 2. In the Review page, check the box on the far left for the review you wish to edit. 

 3. Select More > Edit. 

The Edit Review window opens. You can change the name of the review, set or change an assignee, 
create a restriction, set a date as well as label External/Locked/Closed reviews. 

NOTE 

The External Review is  a simple flag and is only used to help with search results. 
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 4. Click the Edit button at the bottom to save your changes.

A notification appears in the center of the page indicating that the changes are  saved.
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Opening a Review Session
Once a session has been created and filled with scenes, you can open it and play the preview movies for each 
scene in the session in a single video player. From the Review interface, you can add notes to scenes, draw 
annotations, approve scenes or send them for revision. 

You can open multiple review sessions at once. Each session you open will appear in the Open reviews panel 
at the far left of the page.

How to open and play a review session

 1. In the top menu, click Review.

 2. In the Review page, select a review session to open.

Once in a review session,  a list of one or more reviews opens in the far left column. From here you 
can return to the All Reviews page.
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NOTE 

If the column is not visible, click on the Reviews tab in the window to the right.

 

 3. Click on the video player to the right to start playing the movie. The movie will include all the 
scenes in the review session, stitched together in a single sequence. 

NOTE 

Movies can only be stitched together if their options/parameters all match (see 
Delivery section below). 

 4. While reviewing scenes, you can do the following:

 l To pause, resume, mute or adjust the volume of the video, or to skip to a specific part 
of the video, use the controls inside the video player. Space bar will also work to 
pause or resume your video. 

 l If you want to instantly skip to the beginning of a specific scene, select that scene in 
the Scenes panel to the left. 

 l To skip to the previous scene, click  Show Previous Scene  or press the Up key.

 l To skip to the next scene, click   Show Next Scene  or press the Down key.

 l To go to a specific frame, pause the movie near the frame you want to see, then click  
Show Previous Frame  or press the Left key to go back one frame, or click  Show 
Next Frame  or press the Right key to go forward one frame.

 l To hide or display the controls in the video player, click   Video  controls. 

 l Click  Maximize  to hide the Scenes and the Notes panel and expand the video 
player. 

 l To enable or disable looping, click the  Looping  button. When looping is enabled, 
the player  will play the first scene from the beginning after reaching the end of the 
last scene.
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Returning to the Session List and Switching Sessions
Once you have already opened a session, you can return to the session list using a number of ways.

How to return to the session list

 1. Do one of the following:

 l From any page, in the top menu, click Review.

 l From the Review Session page, select any open review or any review that was 
created 

 

 l Once in a review session, you can easily switch from one open review to another. On 
the far left of the page there should be a list of Open Reviews.
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 l If the list isn't visible, select the Reviews tab in the window to the right. 

 

 2. From here you can easily switch reviews by selecting the next open review in the column. 
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Removing Scenes from a Review Session
If you accidentally added extra scenes to a review session, you have the ability to remove them.

How to remove scenes from a review session

 1. Make sure you are in the review session list to edit. 

 2. Select Go To All Reviews.

 3. In the Column Selector on the far right, make sure that the Submission column is checked. 

In the column, the number of Scenes/Snapshots that have been submitted appears. 

 4. Click on the Submission number.

The Submission window opens. 

In the Submission window, all the snapshots/scenes for the current review are displayed. 

 5. Select one or more you wish to delete and then click Delete Submissions. 
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NOTE 

This will not delete the scene from Producer. 
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Deleting a Review Session
Deleting a session will permanently erase it and it will not be accessible again. 

NOTE 

Deleting a review  session will not delete any of its scenes, nor will it delete any of the 
attachments or notes created within the session or undo any of the task status changes done 
within the session.

How to delete review sessions

 1. In the top menu, click Review.

 2. In the Review page, check the box on the far left for the review you wish to edit. 

 3. Select More > Delete. 

A confirmation prompt opens.

 4. In the confirmation prompt, click Delete.
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A notification appears indicating that the item is being removed from the session.
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Playing Preview Movies
You can view the preview movie for any environment, job, scene, or asset in the preview column for that item.

How to play a preview movie

 1. Open the job containing the scene you want to preview.

 2. Do one of the following:

 l To play the scene’s preview movie within its thumbnail in the Production page, click 
on the  Play  button below its thumbnail. 

 l To pause the movie within the thumbnail, click on the  Stop  button.  

 l To watch the preview for an item, click on the  Play  button, or click in the video 
player to play the movie. 

 l Press the Stop button or the spacebar to start the movie from the beginning. 

 l To open the preview movie for a scene in high resolution, click on the  Expand  
button below its thumbnail. The preview movie will open in a new tab. 
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Adding a Note to a Scene in a Review Session
Notes can be added to scenes in a  review session to make comments and suggestions, request corrections, 
point out details or  otherwise communicate important information about a scene to project collaborators.

NOTE 

 l Scene notes can also be added and viewed in both the Production page and in the My Tasks 
page.

 l It is also possible to draw annotations over a frame in a scene and attach it to a note.

How to add notes to a scene in a review session

 1. Open the review session containing the scene you wish to review. There can be 4 different columns  
open. 

 2. In the Scenes column, select the scene to which you want to add a note or scroll horizontally in the 
Timeline below the preview area, select the exact frame where you want to add a comment.
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 3. If you want to leave a note for a different process than the pre-selected process of this review, 
select a new process by clicking on the coloured pill, above the comment box, on the left.

NOTE 

This step is OPTIONAL.
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 4. On the top right of the comment box, you may want to edit the “Note Tag”. This tag allows you to 
later arrange notes per review session. For example, all of today’s review sessions notes can be 
tagged with “Retake 1”.

 5. Type your note in the comment box.

There are 4 options to register your comment: 

 l  Approve Scene: Sets the scene review process to Approved in Producer and 
logs your comment with the approval.

 l  Save Note as a Comment: Your note will appear as a comment in the context 
of the current process.

 l  Revise Note: This will set the scene review process to Retake (or Revise) and 
will save your note as the explanation.

 l Optional: You can check the brush to mark an “Artistic Retake” or the wrench to 
mark a “Technical Retake” (or both).
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 l  Set a Custom Status: Select a custom status using the down arrow. 
Once the desired status is displayed, click on it to set the review process of the scene 
to this status and save your comment along.
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Drawing Annotations While Reviewing Scenes
The Review tool allows you to freeze on a specific frame in the preview movie, draw annotations over it using 
a variety of drawing tools, then add this annotation to the scene, as a note.

An annotation is added to a scene as an attachment to a note. They can be viewed from the Review page as 
well as Production and My Task pages by opening the note attachment.

How to draw annotations

 1. Open the review session containing the scene you wish to review.

 2. In the Scenes column, select the scene to which you want to add a note.

 3. Go to the exact frame to which you want to add an annotation by doing one or several of the 
following:

 l Play the video up until it is at the right frame, then pause it.

 l To fast forward to the frame you want to annotate, click and drag on the play head and 
release it when it is at the right frame.

 l To go back one frame, click the   Show Previous Frame  button under the video player or 
press the Left key.

 l To go forward one frame or click the   Show Next Frame  button under the video player or 
press the Right key.

NOTE 

For the keyboard shortcuts to work with the video player, you must click inside 
the Review tool, but outside of the video player.

 4. In the top right, click the Display drawing toolbar  button.

The drawing toolbar appears.

 5. You can use the following tools in the drawing toolbar to draw over the frame:

 l Use the Pen  tool to draw on the frame.

 l Use the Arrow  tool to draw arrows.

 l Use the Box  tool to draw rectangles and boxes.

 l Use the Straight Line  tool to draw straight lines.

 l Use the Erase  tool to erase any drawings..

 l Set the Set Drawing Colour  tool to change the colour of your drawing tool.
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 l Use the Undo Last Drawing  tool to undo the last drawing stroke.

 l Use the Redo Last Drawing  tool to redo the last stroke you undid.

 l Use the  Clear All Strokes  tool to clear all drawings

 6. In the Review process drop-down below the preview area, ensure the process for which you want 
to add an annotation to is selected.

 7. Do one of the following:

 l To only add your annotation to the scene without approving it or sending it for 
revision, click the  Save Note  button.

 l To add the annotation to the scene and send it for revision, click the Revise Scene 
 button.

 l To add the annotation to the scene and approve it, click the  Approve Scene  
button.

The note and its annotation will appear in the Notes column in the middle, near the top. 

If you approved the scene or sent it for revisions, an extra note will appear in the Notes column 
indicating so. The icon next to the scene in the Scenes list will also change to represent its current 
status. 
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Sending a Scene in a Session for Revision
When reviewing a scene in a review session, you can send it back to the project collaborator who worked on it 
to request revisions. You can add a note to specify which revisions are requested, draw annotations over a 
specific frame in the scene to visually indicate what kind of revisions are needed, or both. You can also indicate 
whether the requested revisions are technical or artistic.

NOTE 

NOTE: Adding a note or an annotation is required to send a scene for revisions.

How to send a scene for revisions with a text note

 1. Open the review session containing the scene you wish to review.

 2. In the Scenes column, select the scene that you want to send back for revisions.

 3. In the Enter your comments here text box, type in the content of your note.

NOTE 

You must include a note or annotation drawing when sending sessions for 
revision.

 4. Click  Revise scene  to send the scene for revisions.

 5. In the Select the type of revision dialog, choose whether the note is Regular, Artistic, Technical, or 
Both. 

The status of the scene’s current process is set to Retake. The note appears in the Notes column. In 
the Scenes column, two curved red arrows appear on the left of the scene.
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Approving a Scene in a Session
Once a scene has been reviewed and any notes have been implemented, it can be approved. 

How to approve scenes

 1. Open the review session containing the scene you wish to review.

 2. In the Scenes column, select the scene that you want to approve.

 3. If you want to add a note while approving the scene, type in the content of your note in the Enter 
your comments here text box.

 4. Click  Approve Scene  to approve the scene.

The approval note appears in the Notes column. In the Scenes column, a green checkmark appears 
on the left of the scene.
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Viewing Notes in a Review Session
In the Review page, you can choose whether to view all notes for the items in a session at once, or to only see 
the  notes for the scene currently highlighted in the Scenes list. Notes are listed from newest to oldest.

How to view notes for all the scenes in a review session

 1. View the session whose notes you wish to view

 2. Do one of the following:

 l In the Notes column, click the Filter  button. In the drop-down menu, click For all 
scenes.

 l Click the title of the Notes list.

Only notes for all session items will be visible.

How to view only notes for the current scene in a review session

 1. To return to only viewing notes for one item at a time, do one of the following:

 l In the Notes column, click the Filter  button. In the drop-down menu, click For 
current scene.

 l Click the title of the Notes list. 

Only the notes for the current item will be visible again. 
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Moderating Notes
For this to work, a user must be tagged as a Moderator and another as a Moderated Person by the 
administrator.  As a Moderated Person, their notes will not reach the general public in the production 
immediately. They will have to go through a Moderator(s) in order for their notes to get to the rest of the 
production. This is a safeguard for all involved.

Once the Moderators and the Moderated are in place, notes from the moderated will have to be screened by 
the moderators of the production.

How to moderate directors notes

 1. To add a user as a Moderator or Moderated Person, in the main menu, select Settings. 

 2.  In the Settings tab, select Security.

 3. Find the group in the production you wish to be the Moderator or the Moderated. 

 4. If you need to add or subtract names from those groups, in the User Assign tab, select the User  
icon .

The Assign Users to Group dialog box opens.

 5. Use the check box to add or remove users from the associated group, the click Save.  

 6. In the Global Rules column, select the Edit icon.

The Permissions Manager dialog box opens.
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 7. In the Data Manipulation Permissions section, check the Moderator and Moderated checkboxes.

 8. Click Save.

Now whenever a Moderated person writes a note—see Writing Notes, the status To Moderate is 
added within the note. The Moderated has the ability to edit their notes.

The To Moderate Status also appears in the Notes column of the Open Tasks tab for any user 
designated as a Moderator.
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How to view and moderate notes

 1. In the main menu, select Review.

 2. In the Review tab, in the Open Reviews section, select a review.

In the Notes for [scene name] section, the notes to moderate are displayed. The notes are marked in 
Orange. 

By default you will be able to see one scene at a time. To see all scenes to moderate in this review 
session, click on the green Filter notes displayed icon and select For all scenes.

 

 3. Select one of 3 options: 

 l Contest, if a note is contested, it will NOT appear in Open Tasks of the Moderated 
person, but will appear in the Notes in the review session.

 l Edit, if a note is contested, click on Edit to place a note as to why.

 l Confirm, if a note is approved it will appear in full view of the production.

Alternatively, if you as the Moderator agree with all notes, click on the Confirm Suggestions 

 button to confirm all. 
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If there is a contested note, the Confirm Uncontested Suggestions  button 
appears. 

NOTE 

Anyone who is not a moderator will not see any notes from the Moderated UNTIL they are 
approved by the Moderators. 
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Closing and Reopening Notes in the Review Session
When a note is created, its status is set to Open. Notes can be closed to indicate that they have been 
acknowledged or tended to, and they can be reopened to indicate that they need further attention.

To avoid cluttering the Notes column, notes that have been closed are hidden by default. It is possible to 
display them so that they can be viewed reopened if needed.

How to close a note

 1. Open the review session containing the scenes for which you want to close or reopen notes.

 2. Do one of the following to display the note you want to close:

 3. In the Scenes column, select the scene containing the note you want to close.

 4. Make the Notes column display the notes for all the scenes in the review session.

 5. In the Notes column, find the note you wish to close.

NOTE 

All new notes are  Open by default.

 6. To close an open note, check the checkbox in its bottom-right corner. 

The status of the note is be set to  Closed. Unless you enabled displaying closed notes in the 
Notes column, it will disappear from the Notes column.

How to reopen a note

 1. Open the review session containing the scene for which you want to reopen a note.

 2. In the Notes column, click the Search button. 

279



 3. In the drop-down menu, make sure Closed is checked.

Closed notes appear in the notes list. 

 4. Do one of the following to display the note you want to reopen:

 l In the Scenes column, select the scene containing the note you want to close.

 l Make the Notes column display the notes for all the scenes in the review session.

 5. Find the note you wish to reopen.

 6. To open a closed note, check the checkbox in its bottom-right corner. 

The note will now be  Open.

 7. To hide the other closed notes, click the  Filter  button again. 

 8. In the drop-down menu, uncheck the checkbox next to Closed.

All closed notes will now be hidden from view. 
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Downloading Reviews
Producer gives you the ability to download the reviews on your local machine.

How to download reviews

 1. In the top menu, select Review.

You will then see Open Reviews, Names of the Reviews and Open Submissions.

 2. To view a submission, click on the number in the submission column. 

The Submission window opens.

 3. You can now download individual reviews by clicking on the check box on the far left and then on 
the blue button in the Actions column. You may select as many check boxes as you like but you 
must select each download button to download individually. 
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 4. You can also download multiple scenes at the same time into a Zip folder. Select all the scenes you 
wish to download and then click on the Download button above the entries. 

 5. If you wish to download a full review with all the videos stitched together, select the review you 
wish to open from either the Open Reviews area or by selecting the Open Review  button from 
the Actions column. 

A new window opens. 

 6. In the Scenes area, check the select all boxes  or select the individual videos you wish to have 
stitched together.

 

 7. In the Play window, select the more options button  to the bottom right of the screen. 

A new window opens. 

 8. Select Download. 
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NOTE 

If there are red lines separating the videos, there was a problem stitching the 
videos together. It could have be cause by a number problems, ie:  video codec, 
audio codec, fps, timebase, aspect ratio.
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Chapter 11: Importing from Storyboard Pro
This procedure will allow you to create all the scenes in Producer and import the animatic and meta-data 
directly from Storyboard Pro.
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Importing from Storyboard Pro
This section explains how to  export data from Storyboard Pro and import it in Producer.

This is a 2-step procedure:

 l Exporting scenes metadata and animatic from a Storyboard Pro project

 l Importing these scenes and animatics into Producer using Producer Link (see Installing Producer Link)

How to export data from Storyboard Pro

There are 3 steps to export your data:

 l Add leading Zeros

 l Export CSV from Storyboard Pro

 l Export Movie files from Storyboard Pro

Add leading Zeros

 1. Go to Preferences > Naming tab, select Automatically Add leading Zeros. 

 l In Storyboard Pro, make sure your scenes are named with leading zeros (for example: 01, 
02, 03 or 001, 002, 003 and not simply 1, 2, 3) 

 l Enter the Minimum Number of Characters. 

 l In the Top menu, click Storyboard and select Rename Scene. 
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 l Save your SBP project.

Export CSV from  Storyboard Pro

 1. From Storyboard Pro, choose File / Export / CSV

 2. Uncheck the “Transitions” option

 3. Click Export
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Export Movie files from Storyboard Pro

 1. From Storyboard Pro, choose File / Export / Movie

 2. Fill in the Destination Path

 3. Leave the File Pattern field blank

 4. In One Clip field, select per Scene from the drop-down list

 5. Click Export

288

Producer 22 User Guide                          



Chapter 11: Importing from Storyboard Pro

How to import Storyboard Pro data in Producer

 1. Determine which workflow process will be used. 

We recommend that you create a process "Animatic" in your scene workflow.

 2. Open Producer Link application.
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 3. From Producer Link main menu or tray, select “Import from Storyboard Pro” (“Storyboard Pro 
Import”)

NOTE 

If you are not logged in, this menu option will not be available.

 4. Fill all the fields.

NOTE 

If you have created an animatic process, select “Animatic” from the drop-down list.

 5. Click “Import CSV”.

290

Producer 22 User Guide                          



Chapter 11: Importing from Storyboard Pro

You can monitor the import process by scrolling down. In Producer, refresh your Production page to see 
the new scenes.

How to download Producer Link

To download the Producer Link, you can follow the steps below.

 1. Select “Downloads & Resources” from the menu.
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 2. Click the Producer Link file for your platform.
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Chapter 12: Reports 

Report Categories

There are four categories for reports:

Category Description

Workload View how much work everyone has and reassign tasks as needed.

Summary Show an overview of a project along with a pie chart.

Productivity Track the amount of work that has been done over time along with a bar graph.

Other Miscellaneous reports that include progress reports and job tasks reports.
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General Interface
Reports allow supervisors, directors, and producers to analyze data and progress through a variety of 
customizable tables.

You can navigate to this section by selecting “Reports” in the top menu.

By default, the page will bring you to the “Add Report” section. You can choose to select an existing report 
from the sidebar or continue creating a new one.

Once a report is generated, it is possible to save it for later and share it with other people.

You may also choose to display only the data table and graphs for the current report, a mode known as the 
“Distraction Free Mode”, by pressing on the four-arrows button.
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How to generate a report

 1. From the left panel, click on the “+ Add Report” button, to clear any previous reports that may be 
displayed.

NOTE 

You may hide the sidebar, to maximize the report area. You can always bring it back 
later, the same way you are hiding it, by clicking on the “Show or hide sidebar” button 
(the “burger” icon).                         

 2. From one of the drop-down boxes, select the type of report you are interested in. For example, in 
the workload reports, you can choose from “Scenes” or “Assets”.
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 3. From the “Search Criteria” section, restrict the search to your liking. You can choose to focus on a 
specific criteria or a combination of them. Press the “Search” button when you are ready to proceed.

How to filter data in the reports

Once a report is generated, it is possible to filter its data without using the Search Criteria (which would 
fetch new data from the database). This can be done using the gear icon next to any of the headers.

These headers can be dragged and dropped within the table to customize its navigation.

 1. For example, you can choose to display data for specific assignees in Summary and Productivity 
reports. To do this, click on the gear icon for “Assignee”
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 2. From the list of assignees, select the ones whose numbers you would like to see. For example, let’s 
look at the data for Carina Allen and Charlie Simmons. Click “Apply” to confirm the filtering.

 3. Note how the “Assignee” header now has a funnel icon to indicate that it is being filtered.

 4. Now, drag the “Assignee” header to the top of the first column. An arrow icon appears and can be 
expanded to view the custom data.

In this example, each assignee can be expanded to view the number of processes in each status. 
You can see that “Carina Allen” currently has two “Layout” tasks in progress and one to be 
validated.
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How to customize your reports

All Producer reports can be customized. As an example of customization in the Workload reports, we will 
choose to add the number of frames to the number of tasks and we will use conditional formatting to 
highlight higher tasks numbers. We will then save this report so it can easily be reused at a later time.

 1. After generating a report, click on the “Fields” icon at the top right of the Report data section. (Note 
that this icon does not appear in the “Distraction Free mode”)

 2. From the All Fields list on the left, drag the “#Frames” into the “Values” box at the bottom right. 
Click Apply.
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The Report data now shows the number of frames next to the number of tasks.

 3. Now, click on “Format” and then “Conditional Formatting”.

 4. Click on the “+” icon to add a condition.

 5. On the first line, for “Value”, select “Distinct scene”. Then select “Greater than or equal to” and 
enter the number “5”.
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 6. Next, click on the letter “A” to configure the format. For this example, click on Highlight, select the 
colour orange and click Apply.

 7. Click Apply to confirm the conditional Formatting. Number of tasks greater than or equal to 5 are 
now highlighted, making it easy to spot a heavy workload.
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How to save a report

 1. To save this report for usage at a later time, simple fill in the report name and press the "Save" 
button at the top.

The report will now appear in your list of reports in the sidebar. It has been saved with your customization.

How to share a report

 1. After creating or selecting a report, select the option “Share this Report”.

 2. Click the “Save” button.

The report can be shared globally, to a specific user or group of users.

Shared reports will be displayed in the left panel under the section “Shared with me”

How to export reports

This procedure will allow you to export the data locally so that you may use it in another software, such 
as a spreadsheet editor.

 1. After having created a report, scroll to the “Report Data” section.

 2. In this section, hover over the “Export” button to display a list of export options.

 3. Click on one of the options to download the report data.

For example, clicking on “To CSV” will download a .csv document containing all the data currently 
displayed.
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A .csv document downloads.
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Workload Manager
Keeping track of how much work everyone has on their plate is an important part of a supervisor’s duties. An 
artist can get overwhelmed or late when tasked with too big of a workload. On the other hand, artists can end 
up waiting for work if too little has been assigned to them.

The Workload Manager is a tool specifically designed to address this need.
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User Interface

Report Data

By default, Workload Reports will show a list of key assignees and their number of processes by their status 
of completion. Job and Scene details can be shown by expanding the rows. These headers can be reorganized 
to customize the way the data is displayed.

NOTE 

For more information about the Reports interface and how it can be customized, see  User Interface 
in the Reports.

With this table, it is simple for managers to see how much work is remaining for specific people and whether 
tasks should be reassigned.

Reassign Selection

Unlike other types of reports, Workload Reports do not have a visual graph to display data.

Instead, there is a “Reassign Selection” section. This allows managers to reassign tasks in the case where 
assignees have too much or too little work on their plate.
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How to analyze a Workload Report

First, create or select a Workload Report. Here is a sample and description of the various areas.
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NOTE 

All headers with a gear icon can be reorganized and be used to filter data. See How to filter 
data in the reports for more information.

Vertical headers description:

 l Key assignee:  This first column lists the assignees of the various manual (non-
approval) tasks.

 l Job: Clicking on the triangle icon preceding an assignee will expand to show the names of 
the jobs containing tasks assigned to that user.

 l Scene: Clicking on the triangle icon preceding a job name will expand to show the names of 
scenes within that job that are assigned to that user.

 l Horizontal headers description:

 l Process: This header lists the processes present in the scenes’ or assets’ workflows.

 l Process group: Adding this header to the table will show processes by group rather than 
individually.

 l Process by Assignee: This header lists the processes present in the scenes’ or assets’ 
workflows while also allowing the display approval processes by assignee.

 l Status: Display the statuses of the various tasks.

Key concepts:
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 l Key assignee: Key assignee varies from regular assignee in that they refer to the assignees of 
manual tasks (ie not approval tasks). Consider the example below:

The first column on the left lists Charlie Simmons as the key assignee. Because Charlie’s 
information has been expanded to display which scenes are assigned to him (line 8), we know that 
the process Layout of scene 110_002 is assigned to Charlie. However, the Layout_check (an 
approval process) of the same scene is most likely assigned to someone else (a supervisor). Still it 
is listed on the same row since the key of that list is key assignee, the assignee of the manual task.

 l Process group: A process group is generated automatically and comprises a manual process and 
all the approval processes immediately following it in its workflow. The group is named after its 
manual process. Consider a workflow made up of the following seven processes (where the 
processes in italic are approval processes).

Layout, Layout_check, Layout_app, Setup, Anim, Anim_check and Anim_app

This workflow would be divided in 3 process groups:

 l Layout: Layout, Layout_check, Layout_app

 l Setup: Setup

 l Anim: Anim, Anim_check and Anim_app

A process group can be expanded into its constituent processes simply by clicking on the triangle 
icon preceding it.

Process by Assignee: To simplify the data shown to supervisors, it is possible to view 
processes by approval assignees. Consider the example below:
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This table shows the data for Carina Allen and Jane Sin, who are both working on tasks to be checked by 
Jade Jonah. With this report, Jade Jonah can easily track the workload of each member of their team.

How to reassign tasks using the Workload Manager

Once you generated a workload report and analyzed its data, you can now proceed to make adjustments 
to the workload by reassigning tasks.

 1. For this example, let’s have a single process and a single status as search criteria. Say “Rough_
Anim” and “Pending”

 2. Looking at the Report Data, you can tell that Jade has 8 scenes to do while Jonathan has only 1.
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 3. Clicking on the 8 scenes of Jade will bring up the details of these scenes in the ‘“Reassign 
Selection” section below.

 4. Clicking on the scenes you would like to reassign. Note that you can use Control-click (Command-
click on Mac) to select multiple entries.

 5. From the drop-down menu, pick the name of the user to whom you would like to reassign these 
scenes and click the Reassign button.

309



The changes are immediately reflected in the Report data, showing that 5 scenes would now be 
assigned to Jonathan, if you were to go ahead and commit these changes.

 6. You could now continue to reassign various tasks to balance the workload of everyone. Once you 
are happy with the changes, click on “Apply Changes”.
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Chapter 13: Producer Link
Producer Link is a desktop application allowing you to upload preview files as well as link assets to Producer 
from your computer. The desktop application can be downloaded from the Downloads and Resources section 
of Producer and installed locally for each user who will need to use Producer Link.

 

 

311



Producer Link
Web applications such as Producer cannot access files on a computer, unless a specific file is uploaded. 
Producer Link bridges the communication between Producer and local files.

The Producer Link desktop application can be used directly with Producer without the need of Harmony or 
Harmony Server. It can be used to link files such as PSDs as well as open the linked PSD files directly from 
Producer. It can also be used to create scenes generated in Storyboard Pro as well as uploading the matching 
preview movies. Finally, it can also be used to link scene snapshots such as Maya projects.

NOTE 

Assets are linked to Producer from your external centralized repository. Only preview files such as 
thumbnails and movie preview are uploaded to Producer.

In addition to handling uploading assets from CSV, external Assets, scene snapshots, or StoryboardPro 
import, the user can manage, open and export offline scenes. Please refer to the following sections in the 
documentation for more information on each topic:

Installing

Logging in

Interface

Configuration

Uploading Assets

Offline Scenes

Command Line

Setup Overview

Producer and Producer Link without Harmony Setup

312

Producer 22 User Guide                          



Chapter 13: Producer Link

Producer and Producer Link with Harmony Setup
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Installing Producer Link
Producer Link installer can be downloaded from the Downloads and Resources section of Producer. It can be 
installed on Mac (Universal Build) and Windows.

How to install Producer Link

 1. Log into your Producer instance.

 2. In the user profile drop-down menu, select Downloads & Resources.

 3. In the Downloads & Resources window, click on the Producer Link installer matching your 
operating system.
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 4. Once downloaded, click the Close button.

 5. Launch the installer and follow the on-screen instruction to install the application.

 6. The application can be found here:

 l macOS: /Applications/Producer Link

 l Windows: C:\Program Files\Producer Link

Even when closing the Producer Link interface, the application is still running in the background. To 
completely stop the application, you must either quit the background process or from the top menu, select 
Exit.
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Logging into Producer Link
To access the Producer Link user interface, you must first log into the application using your Producer 
username.

How to log into Producer Link

 1. In the URL field, type the address to your Producer instance.

 2. In the Username field, type your Producer username.

 3. In the Password field, type your Producer password.

 4. Click Login.

 5. Once the login is successful, click Done.
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Producer Link Interface
Once logged into Producer Link, you can access various functions via the top menu. You can configure your 
workspaces using the Settings in Producer Link menu and upload files using the Upload menu.

To set up your workspaces, you can click on Settings under the Producer Link menu. For more details, refer to  
How to create a workspace from the user interface and How to create a workspace using the command line.

For the Upload menu, you can upload multiple assets from a CSV file, scene snapshots, external assets such 
as PSDs, and import a scene list and the matching movie previews from Storyboard Pro, see Uploading 
Assets.

To open Offline Scene page, you can choose “Open” under Scenes. You can use it to manage the opening, 
exporting and deleting of scenes in the local offline folder. For more details, see Open Offline Scene.

To open Producer web, you can access the Producer menu and choose “Open”.
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macOS has a Producer Link tray icon allowing you to exit the application, access the version number, and so 
on.
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Configuring Producer Link

Interface

The user can configure many settings in the Settings page.

Settings

Below is a description of each configuration option in the Setting page.

Options Description

General Settings
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Options Description

Working Project This project will determine where Producer Link will look for Environments, Jobs and Scenes.

Harmony Offline Mode

Open Scenes in 
Offline Mode

If enabled, clicking on the  button from the Production page will export the highlighted 
scene and launch the Open Offline Scene dialog from Producer Link. 

If disabled, clicking on the  button from the Production page will attempt to open the 
scene in database mode. (This is only preferable for machines located in the studio.)  By 
default, the Open Scenes in Offline Mode option is enabled. 

Checkout before 
Export

If enabled, the default value of the Export button will be “Check out and Export” (instead of 
“Export only”).

Cloud Exchange 
Folder

The Cloud Exchange Folder is a locally mounted folder shared from the cloud which is 
synchronized with the Harmony Server Exchange Folder. For this option to work, the user will 
need to install a cloud storage application connected to the studio server, in which every user 
will have their own subfolder used for exporting their scenes offline. The user folders will act 
as an intermediate between the studio’ server and the Local Offline Folder described in the 
next option below. 

Each user subfolder will contains two subfolders: 

Exported: The Exported subfolder contains the *.7z and *.7z.props file.

Imported: The Imported subfolder contains the *.7z file. 

NOTE 

Just to name a few, Google Drive and Dropbox can be used as cloud storage applications. 

The Cloud Exchange Folder option lets the user define where the user cloud storage subfolder 
is mounted locally. 

The checkmark icon   confirms that the path entered in the textfield is valid and recognized 
by Producer link. 

The warning icon   indicates that the path entered in the textfield is invalid or that Producer 
Link was not able to recognize it.   

Local Offline 
Folder

Lets the user define where on his computer the unzipped scene files will be stored to allow 
him to work in Harmony Standalone.
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Options Description

The checkmark  and warning  icons are used to confirm the validity of the path entered in 
the textfield.

Harmony Versions

Alias
Lets the user write an alias for his Harmony version path. The ID provided within this field 
does not have any other purpose other than providing a name to differentiate each Harmony 
Version listed within the Harmony Versions section.

Harmony Path Here, the user defines the Harmony Premium.app location.  The checkmark   and warning  
icons are used to confirm the validity of the path entered in the textfield.

Add Allows the user to add another Harmony version to the Harmony version list.

Default Lets the user define which Harmony version will be defined as the default one. 

Action Lets the user remove the Harmony version, by clicking on the Remove Harmony Version  
button .

Workspaces

Alias
This field lets the user write an alias for his Workspace Folder path. The ID provided within 
this field does not have any other purpose other than providing a name to differentiate each 
workspace listed within the Workspaces section.

Workspace 
Folder

The Workspace Folder defines the path for a single resource or asset type folder. The more 
resources or assets that a user will have to play with, the more workspaces will be needed to 

be defined in Producer Link.   The checkmark  and warning   icons are used to confirm the 
validity of the path entered in the textfield.

Default Lets the user define which workspace will be defined as the default one. 

Action Lets the user remove the workspace, by clicking on the Remove Workspace  button.

Add Lets the user add another workspace to the workspace list.
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As users will be accessing files from various locations and various computers, the path to those files will be 
different for most users. For example, files could be stored on a centralized cloud location such as DropBox or 
a centralized server in the studio. Each computer will have a different path to access these files.

Workspaces

To allow everyone on your team to access and open files, your data such as backgrounds, library assets, Maya 
projects and so on must be located in a centralized repository accessible by everyone who needs access to it to 
work. Each computer must be able to access the location via an absolute path that will be configured in 
Producer Link.

You can have one or multiple repositories. These shared locations are called workspaces. Each location will be 
identified in Producer with a Workspace alias. The Workspace Alias will then be linked to the absolute path 
from each computer who will need to access the location.

Everyone will be using the same Workspace aliases, but everyone will most likely be using a different 
absolute path to access these shared locations from their computers.

Therefore, the first step will be to create this shared space and give access to the users. This is done outside of 
Producer and Producer Link. This is an internal operation to your organization.

How-Tos

How to create workspaces or Harmony version aliases

To create a new workspace or new Harmony version alias, you can click the Add button and fill in the 
information for the row. It should auto-save once you click anywhere else in the page. Ensure you have 
selected a default by checking the checkbox if you have multiple rows.
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To configure workspaces using the command line, you can refer to Producer Link Command Line.

How to configure Producer Link to work remotely on a Harmony Database

To simplify working from home on a Harmony database, a studio using Producer can choose to set up and 
use the Harmony Offline Mode. See Harmony Integration > Working Remotely. Once the above is 
completed by a studio system administrator, the user may now configure Producer Link as detailed below.

Once the above is completed by a studio system administrator, the user may now configure Producer Link 
as detailed below.

 1. In Producer Link, make sure you are connected to your Producer instance. If you are not, you should 
“Login”.

 2. In Producer Link, open “Settings”

 3. Under General Settings, choose the Working Project from the drop-down list.

 4. Under Harmony Offline Mode, make sure the “Open Scenes in Offline Mode” option is checked (this 
is the default value).
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 5. Enable the “Check out before Export” option if you would like the default value of the Export button 
to be “Check out and Export” (instead of “Export only”).

 6. Still under Harmony Offline Mode, click on the folder icon at the end of the “Cloud Exchange 
Folder” line and browse to where the cloud folder that was shared with you is mounted on your 
machine. This should be a subfolder named after your Harmony username.

NOTE 

The path may appear slightly different from the sequence of folders you have just 
browsed since some cloud storage services may use “shortcuts”. This is no cause for 
concern.

 7. Under Harmony Offline Mode, click on the folder icon at the end of the “Local Offline Folder” line 
and browse a folder of your choosing where offline scene files will be stored and uncompressed on 
this remote computer to work in Harmony Standalone.
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Creating Workspaces

How to create workspace from the user interface

 1. Launch Producer Link.

 2. In the top menu, select Producer Link > Settings.

 3. Click the Add button.

 4. In the alias field, type the alias of the new workspace and click on the folder icon to pick the 
corresponding folder path.

 5. It should auto-save once you click anywhere else in the page. Ensure you have selected a default 
by checking the checkbox.

How to delete a workspace

Launch Producer Link.

In the top menu, select Workspaces > Edit.

Beside the workspace to delete, click the Delete Workspace button.

How to create a workspace using the terminal or command prompt

You can set up your workspaces directly with command lines instead of using the user interface. Use the 
following command to configure workspaces:

 l macOS: ./Producer\ Link config --set-workspace WorkspaceName --root /path/to/my/workspace

 l Windows: “Producer Link.exe” config --set-workspace WorkspaceName --root 
/path/to/my/workspace

where you replace WorkspaceName with the name of the location where your assets will be located and 
/path/to/my/workspace with the root path to that folder.

Configuring Harmony Server to Recognize Workspaces

Once your workspaces are created, you can export the configuration from Producer Link as a json file. That 
json file needs to be copied on the Harmony Server in the USA_DB directory. The paths in the json file must be 
paths that can be accessed from the Harmony Server so that assets can be baked into Harmony scenes during 
the Assembly (Scene Setup) process.

Note that if you create new workspaces, you will need to reexport a new json file.
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To learn more about assembly, see About Assembly and to learn more about baking, see About Sending 
Assets to Harmony (Baking).

How to configure Harmony server for baking

 1. Completely close Producer Link, including the back-end process.

 2. On the Harmony Server, in the Terminal or Command Prompt, browse to Producer Link.

 3. Use the following command to export the workspaces as a json file:

 l Mac OS: ./Producer\ Link config --export-workspaces

 l Windows: “Producer Link.exe” config --export-workspaces

 4. Once the json file is exported, a message is displayed indicating the path where the file has been 
saved. Browse to that path to find the file.

 l Example: Your WebCC workspaces have been written to /Users/username/workspaces.json

 5. Copy and paste the workspaces.json file to /USA_DB. The file has to be located on the Harmony 
Server at the root of USA_DB.

 6. You can open the json file to verify that the paths are accessible from this location. If the paths are 
not accessible, the baking process will fail.
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Uploading Assets
Using Producer Link, you can upload assets directly to Producer from your local computer. Harmony is only 
required if you are uploading assets created with Harmony. WebCC is not required for the upload. Producer 
Link communicates directly with Producer.

In order to link assets and upload previews, workspaces need to be configured. See  Configuring Producer Link.
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Uploading Assets from CSV

Upload Assets from CSV can be used to provide Producer with a list of assets to create and previews to 
upload. This process is very useful when you have a series of existing assets, such as hundreds of 
backgrounds and would like to load them in Producer in a single operation.

 l The actual source file, specified by the \"Relative Path\", will not be uploaded but its path will be 
registered for later access.

 l The Thumbnail will be uploaded.

How to upload CSV files with thumbnails

 1. In the top menu, select Upload > Assets from CSV.

 2. In the Project field, select the Producer Project. This is not the environment. Assets are global to the 
Producer project.

 3. In the Source field, browse or drag and drop the CSV file containing the list of assets to be 
uploaded.

 4. Select the Harmony version alias you have set up in the Settings page.

 5. Click Upload Assets.

CSV Format Specifications

The CSV field delimiter is a semicolon (or comma). The first line of the CSV must contain the various field 
names.
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The following fields are recognized (case insensitive):

Field Description

Asset Name It is a mandatory field, unless an asset code is specified.

Asset Code It is used to update an existing asset.

Workflow Code

To determine which workflow will be used with this asset.

NOTE 

This cannot be used to update existing assets.

Type Must match an existing asset type - Optional.

Category Must match an existing asset category - Optional.

Workspace Id Workspaces are predefined using Producer Link.

Relative Path
Path of the source file for the asset, relative to the Workspace. In the case of a 
Harmony Standalone template, must point to the .xstage file.

Thumbnail Path Absolute Path of a file to be uploaded and used as thumbnail in Producer.

Process Name Specify the process for the uploaded asset and note.

ExternalRef Type

Use one of these two ExternalRef Types: 

 l Harmony Standalone (Standalone scene used to build a template) 

 l ref (any other type, such as third party software images) 

Note
Note for the asset. Quote your note e.g. \"Your note,;\" so that , or ; are not 
recognized as separators.

Note Attachment Path Absolute path of a note attachment.
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Sample CSV
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Uploading Scene Snapshot

Scenes are any files that are used to build your scenes such as Harmony standalone files, Maya projects, movie 
files, and so on. You can use the Upload Scene Snapshot to link Producer to the scene files on your centralized 
repository as well as uploading the matching preview. Once the Scene file is linked, you can open the file 
directly from Producer, regardless if the application is Harmony, Maya, Photoshop, or any other tool you are 
using in production.

To upload scene snapshots, a workspace must be defined in the centralized repository. See How to create a 
workspace from the user interface.

How to upload a scene snapshot

 1. In the top menu, select Upload > Scene Snapshot.

 2. In the Project field, select the Producer project containing the Environment you are uploading to.

 3. In the Environment field, select the corresponding environment.

 4. In the Job field, select the corresponding job (episode, sequence, etc.).

 5. In the Scene field, select the scene you are linking an asset to. As you start typing the name, 
existing scenes will be populated. Note that the scene must already exist in Producer.

 6. In the Process field, select the Process (task) you are linking your scene asset to.

 7. In the Source field, click Choose File and browse to the location of the file you are linking. If it is a 
Harmony file, select the *.xstage file. If it is a Maya file, select the *.ma file. The executable file 
must be selected in order for Producer to launch the application and open the file later on. See 
Opening an Asset from Producer.

NOTE 

The file you are looking for must be located within the workspace (shared location). If 
not, an error message will be displayed.
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 8. In the Preview section, browse for a flattened image, such as a PNG or JPG, to preview what the file 
is in Producer.

 9. Click Create Snapshot.

Example with a Harmony File
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Example with a Maya File
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Uploading External Assets

You can link external assets such as background PSDs or Harmony templates to Producer and upload a 
preview for it. These assets can then be directly opened from Producer or baked in a Harmony scene. To 
upload an external asset to, the asset must first exist in Producer. To learn how to create assets, see Creating 
Assets.

How to upload an external asset

 1. In the top menu, select Upload > External Asset.

 2. In the Project field, select the Producer project. This is not the environment. Most of the time, you 
will select Main Project unless a different Producer project has been created.

 3. In the Asset Name field, start typing the name of an existing asset (already in Producer). As you 
type the name, existing assets will be displayed in the drop-down menu. Select the matching asset.

 4. Once the asset name is selected, in the Process field, the matching workflow tasks appear. Select 
the task matching your upload.

 5. In the Source section, click the Choose File button to browse for the file to upload. Note that the 
asset has to be located within the set workspace. If you select a file outside of the workspace, the 
upload will result in an error.
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 6. In the Preview section, click the Choose File to select a flattened image such as a PNG or a JPG to 
display the preview in Producer.

 7. Click Create Snapshot.

Once the process is complete, a success message appears.

In Producer, the file is linked and the preview file is uploaded and updated.
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Opening an Asset from Producer

Once a file is linked via Producer Link, it can be opened directly from Producer by opening the Settings window 
of that asset.. It can also be downloaded and deleted. From that same settings section, previously uploaded 
versions can be accessed.

How to open an external asset

 1. In the Asset list, hover over the asset preview.

 2. Click the Settings Gear icon.

 3. In the pop-up window, click the Open File icon. If you would like to download the asset, click 
Download.

 4. Once you click Open File, you will be prompted to open Producer Link. Confirm the request to open 
Producer Link.

 5. To access previous versions, click the Process Version drop-down arrow.
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Uploading a Storyboard Pro Scene List

When creating a project in Storyboard Pro, the scene list is already created and an animatic movie preview for 
each one of these scenes can easily be exported. You can use Producer Link to automatically create scenes in 
Producer and upload the matching movie preview. This process is very handy if you are working on a project 
using Storyboard Pro but are not using Harmony Server.

How to export your data from Storyboard Pro

 1. In Storyboard Pro, make sure your scenes are named with leading zeros (example: 01, 02, 03 or 
001, 002, 003 and not simply 1, 2, 3). You can use the Preferences > Naming  Automatically Add 
leading Zeros and Minimum number of characters as well as the function Storyboard > Rename.
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 2. Save your SBP Project.

 3. From Storyboard Pro, select File > Export > CSV.

 4. In the Export to CSV dialog box, in the CSV Export Options section, disable the Include Transitions 
option.

 5. Click Export.
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 6. From Storyboard Pro, choose File > Export > Movie.

 7. Select a Destination Path.

 8. Leave the File Pattern field empty.

 9. In the One Clip field, select Per Scene.

 10. Click Export.
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How to import Storyboard Pro data in Producer

 1. In Producer Link, select Upload > Storyboard Pro Import.

 2. In the Project field, select the Producer project containing the environment you will be creating 
scenes for.
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 3. In the Environment field, select the corresponding environment.

 4. In the Job field, select the corresponding job (episode, sequence, etc.).

 5. In the Scene field, select the scene you are linking an asset to. As you start typing the name, 
existing scenes will be populated. Note that the scene must already exist in Producer.

 6. In the Workflow field, select the scene workflow that will be associated to the scenes.

 7. In the Process field, select the Process (task) you are linking your scenes to, most likely Layout or 
Animatic.

 8. In the Customer Media Folder field, browse to the folder containing the rendered movie files.

 9. Click Import CSV.
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 10. You can monitor the import process by scrolling down.

 11. In your Producer, refresh your Production Page to see the new scenes.

344

Producer 22 User Guide                          



Chapter 13: Producer Link

Open Offline Scenes
Producer Link’s Open Offline Scene dialog helps remote users export and manage their offline scenes, and 
verify that they are up to date with their counterparts on the remote Harmony Database.

NOTE 

To be able to access this page, the user is required to check the “Open Scenes in Offline mode” in 
the Settings page.

When opening a scene from Producer Web Interface’s “Open in Harmony” button , Producer Link will take 
care of comparing any local version with the server version, requesting an export and opening exported scene 
in Harmony.

It can also be used on its own to open and manage any offline scenes.

NOTE 

Some specific usage scenarios are described in Harmony Integration > Working Remotely section.
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Command Line Interface
Using a Terminal or a Command Prompt, Producer Link can be modified.

You can navigate to the Producer Link application using the following command:

 l macOS cd /Applications/Producer\ Link.app/Contents/MacOS

 l Windows: cd “C:\Program Files\Producer Link”

You can access the list of commands using the following command:

 l macOS: ./Producer\ Link config --help

 l Windows: “Producer Link.exe” config --help"

Use the following command to configure a project for Producer Link:

 l Mac OS: ./Producer\ Link config --set-project project_name

 l Windows: “Producer Link.exe” config --set-project project_name

Most of the time, the project name will be main_project. If you created a different project (not the environment, 
but Producer project), use that project name.

How to create a workspace in command line

You can set up your workspaces directly with command lines instead of using the user interface. Use the 
following command to configure workspaces:
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 l macOS: ./Producer\ Link config --set-workspace WorkspaceName --root /path/to/my/workspace

 l Windows: “Producer Link.exe” config --set-workspace WorkspaceName --root 
/path/to/my/workspace

How to export workspaces in command line

 l Use the following command to export the workspaces as a json file:

 l Mac OS: ./Producer\ Link config --export-workspaces

 l Windows: “Producer Link.exe” config --export-workspaces

 l Once the json file is exported, a message is displayed indicating the path where the file has been 
saved. Browse to that path to find the file.

 l Example: Your WebCC workspaces have been written to /Users/username/workspaces.json

 l Copy and paste the workspaces.json file to /USA_DB. The file has to be located on the Harmony 
Server at the root of USA_DB.
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